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ALMA timeline

* March: Call for proposals (CfP)
* April: Proposals due
* August: Grades for proposals are announced

e September: Phase 2 of proposal submission
(review of the Scheduling Blocks); end of observations
from the previous cycle; ACA supplemental CfP

* October: Observations start for new cycle; ACA
proposals due
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* March: Call for proposals (CfP)
} OT (Phase 1)

* August: Grades for proposals are announced
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* September: Phase 2 of proposal submission
(review of the Scheduling Blocks); end of observations
from the previous cycle; ACA supplemental CfP

* October: Observations start for new cycle; ACA

proposals due (if proposal accepted)
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Cycle 8 2021 ALMA timeline

 March 17: Call for proposals (CfP)

* April 21: Proposals due

e August: Grades for proposals are announced
* September 8: ACA supplemental CfP

* October 1: Observations start for Cycle 8 and
continue with remainder of Cycle 7

* October 6: ACA proposals due



Observing Tool (OT)

* Java desktop application (c8: own version of Java 11)
* Updated each cycle to match ALMA capabilities
* Works on Linux, Mac, Windows

Download and installing. ALMA OT Installer (recommended)
or tarball (if anything goes wrong with the installer :( )

Documentation: OT Quickstart Guide, OT video tutorials,
User Manual


https://almascience.eso.org/proposing/observing-tool/installer-page
https://almascience.eso.org/proposing/observing-tool/tarball-download-page
https://almascience.eso.org/documents-and-tools/latest/documents-and-tools/cycle8/alma-ot-quickstart
https://almascience.eso.org/proposing/observing-tool/video-tutorials
https://almascience.eso.org/documents-and-tools/latest/documents-and-tools/cycle8/alma-ot-usermanual

Lets propose!

ALMA proposal
Science justification + Technical Justification
Why? How?
4 or 6 pages OT
PDF file

(templates)


https://almascience.eso.org/documents-and-tools/proposing/proposal-template

Lets propose!

ALMA proposal
Science justification + Technical Justification
Why? How?

Science Goals contain the technical specification of your
project. Are limited to one correlator setup, one calibration
strategy, and one set of Control and Performance
parameters.

* Band 3 observations of one or more targets (1 SG)

* Band 3 observations at 0.02” and 4” (2 SG)
 Band 3, Band 4 and Band 5 observations (3 SG)



Now, lets propose!

Example 1. Continuum observations of several targets
(e.g. survey of protostars)

Example 2: Line observations of single target (e.g. study
kinematics of a protostellar disk)

Example 3: Mosaic observations (e.g. mapping a star-
forming filament)



Now, lets propose!

Example 1. Continuum observations of several targets
(e.g. survey of protostars)

Example 2: Line observations of single target (e.g. study
kinematics of a protostellar disk)

Example 3: Mosaic observations (e.g. mapping a star-
forming filament)

0. Register with the (Pl and co-Is)


https://almascience.eso.org/

Open the OT

Linux (terminal): ./ALMA-OT.sh

Mac (double-click): ALMA-OT.app

Startup Options X

What would you like to do?

@® (Create a new proposal

O Create a new DDT proposal

() Open an existing project from disk

O Retrieve a project from the ALMA science archive

[] Do not show this message again
+ oK
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https://almascience.eso.org/proposing/ddt-proposals
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Open the OT
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Open the OT
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For each proposal you must...
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For each proposal you must...
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For each proposal you must...

ALMA Observing Tool (Cycle 8 2021 (MainCall-Phase1)) - Example 1
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For each proposal you must...
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For each proposal you must...
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For each proposal you must.

ALMA Observing Tool (validation OT) - Example 1
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For each proposal you must.

ALMA Observing Tool (validation OT) - Example 1
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Now, lets propose!

Example 1: Continuum observations of several targets
(e.g. survey of protostars)

* 1 Science Goal with multiple targets



Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1
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Example 1. Continuum observations of several targets
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Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1
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Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1
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SinglePoint

Source

Source Name [

| Resolve |

Choose a Solar System Object? [[]

Name of object [Unspecified
Sexagesimal oo |
Syetem = Parallax [0.00000 mas |~
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PM DEC [0.00000 [masyr [+ ]
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All info at once
(scroll down)
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the ALMA Science Portal Science Science Science
2. Create a new proposal by either: Goals Proposal
» Selecting File > New Proposal
« Clicking on the B icon in the toolbar Click on the overview steps to view the contextual help
» Or clicking on this link Importing
3. Click on the & proposal tree node and complete the And

Exporting

relevant fields.




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Eille Edit View Tool Search Help

[@]g]

(Gl (@]

Perspective 1

Project Structure
Proposal

0

Editors

Spectral Setup

Unsubmitted Proposal

% i Example 1
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)

[ General
[ Field setup
[} spectral Setup 4—
[ calibration Setup
[ Control and Performance
[} Technical Justification

one per SG)

Visualisation

In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1
Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.

Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth ene in the other.

Leftrright click to zoom in/out, grab siiding bar to pan
Note: Moving LOL here is for experimentation only - actual setup determined by the windows.

Beerved Frequency TGHe)
0000

Jo000 28040000 290/0000 300/0000 310]0000 330]0000 340]0000 330000

Basebands [

36040000

el

37040000

28010000 30000000 32000000 3a0/0000 360l0000
Rest Frequency (GHz)
Overlays: Receiver Bands Transmission DSB Image [] Spectral Lines| select ines to Overlay
ur Column Density: @ Automatic Choice C Manual Choice [0.913mm (3rd Octile}
: ; e e Cte a n Pan to Spectral Window | ZoomtoBand |  Reset |
b | u e O spactral Line
Spectral Type ® single Continuum
© Spectral Scan
Produce image sidebands (Bands 9 and 10 only) []
Polarization products desired © XX ®DUAL O FULL
Spectral Setup Errors
Single Continuum
Receiver Ban(__[7 [275.0-373.0 GHz] [~
R
sky Frequency |343.50000 =
Rest Frequency 343.500000 GHz
@ Low spectral resolution (TDM)
© High spectral resolution (FDM)
Baseband-1
Spec. Representative
Avg.

Fraction St om0y Toione | Transition Bandwidth, Resolution (smoothed)
L(Full) 336.50000 GHz 1336.50000 GHz [single Continuum 11875.000 MHz( 1670 kmys), 31.250 MHz(27.841 kmjs) n
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Ql

a2

Validation | Validation History | Log

Overview

Y

w

Contextual Help Phase I: Science Proposal
. Please ensure you and your co-Is are registered with p— fy— r—
the ALMA Science Portal Science Science Science

. Create a new proposal by either: Goals Proposal
» Selecting File > New Proposal
= Clicking on the il icon in the toolbar
» Or clicking on this link
. Click on the & proposal tree node and complete the
relevant fields.

Click on the overview steps to view the contextual help

Importin
e

Exporting




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Perspective 1

Eille Edit View Tool Search Help

Project Structure [Editors
Proposal " Spectral Spectral Setup
Unsubmitted Proposal POTRZaTIGN proOUCTs GesTen DUAL  FOLE =
i Example 1 Spectral Setup Errors
[ Proposal Single Continuum
¢ [ Planned Observing el =
¢ {8 ScienceGoal (Science Goal 1)
[ General Receiver Band |7 [275.0-373.0 GHz] [~
% Field Setup S Reset to Standard Frequency I
= <4— (ONne per o
.
[0 calibration Setup sky Frequency  [343.50000
[ Control and Performance
) Technical Justfcation Rest Frequency  343.500000 GHz
® Low spectral resolution (TDM)
g
Baseband-1
e ‘ e opcoper. Transition Bandwidth, Resolution (smoothed) = Representative i
1(Full) 1336.50000 GHz 336.50000 GHz [Single Continuum TR75_000 MA7{_ 1670 km/s)__31 )50 WA7(77 BA1 km/s) [~ o]
58.500 MHz( 52 kn/s), 30.518 kHz( 0.027 km/s)
117.188 MHz( 104 kn/s), 61.035 kHz( 0.654 km/s)
234.375 MHz( 209 kn/s), 122.070 kHz( 0.109 km/s)
O I 468,750 MHz{ 418 kn/s), 244,141 kHz( 0.218 km/s)
937.500 MHz( 835 kn/s), 488.281 kHz( 0.435 km/s)
Baseband-2 1875.000 MHz( 1670 kn/s), 976.563 kHz( 0.870 km/s)
t I [x{Fully [338.50000 GHz [338.50000 GHz [Single Continuum 1875.000 MH2( 1670 km/s), 31.250 MHz(27.841 km/s) 1 [*] |
. O age spect
windows
[2(Fully [348.50000 GHz [348.50000 GHz [single Continuum [1875.000 MHz( 1613 km/s), 31.250 MHz(26.882 kmys) n [] |
O age spectra
Baseband-4
[1(Full) 350.50000 GHz 350.50000 GHz [Single Continuum [1875.000 MHz( 1604 kmys), 31.250 MH2(26.729 kmjs) n [® |
o I
Representative Frequency
The representative fraquency is used in conjunction with the sensitivity entered on the ‘Control and Performance’ page to estimate the reguired
observing time and to set the size of the antenna beam shown in the ‘Spatial Visual' editor. If the transition you are most interested in does
not fall in the centre of the chosen spectral window, its frequency can be changed here. The sky equivalents of the representative frequency are
chown in the targets table below.
350.50000 [+
Rest Frequencies

Feedback

Ql

a2

Validation | Validation History | Log

Overview

Y

. Click on the

Contextual Help

. Please ensure you and your co-Is are registered with
T

the ALMA Science Portal

. Create a new proposal by either:

= Selecting File > New Praposal
= Clicking on the il icon in the toolbar
» Or clicking on this link

relevant fields.

proposal tree node and complete the

Phase I: Science Proposal

submit
Science

validate
Science
Proposal

Create
Science
Goals.

Click on the overview steps to view the contextual help
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Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

File Edit View Tool Search Help Perspective 1
a =& E [EHCIR~ IR

Project Structure 4[Editors
Proposal Spec

Calibration Setup

Unsubmitted Proposal
% i Example 1
¢ Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
st <— (One per SG
[ Control and Performance
[} Technical Justification

Select calibration strategy.

Goal Calibrators

]
o o L G0 S VD SO S S Don t C ange

® system-defined calibration (recommended)

O System-deNined caNbration (force separate amplitude calibration using solar-system object) -
O bsr s ctrcn without an

Astrometry

If you wish positional accuracy that is better than that provided by default (see the Proposer's Guide for more information) then select enhanced accuracy.
@ standard positional accuracy (default)
© Enhanced positional accuracy

DGC Override (observatory-use only)

Validation | Validation History | Log

Ql [ 2]

Overview
Contextual Help Phase I: Science Proposal

1. Please ensure you and your co-Is are registered with — E— = fE—
the ALMA Science Portal Science Science Science

2. Create a new proposal by either: Goals Proposal Proposal
» Selecting File > New Proposal e il e contextua ol
« Clicking on the Bl icon in the toolbar ick on the overview steps to view the contextual help
» Or clicking on this link [ —

3. Click on the & proposal tree node and complete the B

relevant fields.




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

File Edit View Tool Search Help Perspective 1
a =& E [EHCIR~ IR

Project Structure [Editors

Proposal I

Unsubmitted Proposal
7 i Example 1 These parameters are used to control various aspects of the observations, including the required antenna configurations and integration times.
¢ [ Proposal

% [ Planned Observing
T SD?'Z"CSG"‘E‘ (Science Goal 1) Configuration Information
eneral e e
[ Fied setup O n S O Antenna Beamsize (113 *A/D) 12m 16.613 arcsec 7m  28.480 arcsec
D spectra s I —— o @ o m ™ W h at can vou
[ calibration Setup
) Eontrolnd Pertormancs ara m e e rS ACA 7m configuration Most compact 12m configuration Most extended 12m configuration
[} Technical Justification Longest baseline 0.049 km 0.161 km 2548 km t)
S Synthesized beamsize 3.647 arcsec 0.988 arcsec 0.029 arcsec g ‘ ! I
p e r G Shortest baseline 0.009 km 0.015 km 0.113 km
Maximum recoverable scale 19.205 arcsec 8.388 arcsec 0.414 arcsec

Desired Angular Resolution (Synthesized Beam) @ single 2 Range © Any () Standalone ACA

[o.00000 |
Largest Angular Structure in source [Undefined |
Desired sensitivity per pointing [o.00000 |

Bandwidth used for Sensitivity |AggregateBandwidth | +| Frequency width 7.500000 GHz

override OT's sensitivity-based
time estimate (must be justified)  Yes ® No

Science Goal time estimate
(includes configuration and beam information) | TMe Estimate
Simultaneous 12-m and ACA cbservations @)

) Yes ® No

quivalent to Infinity K

Are the observations time-constrained?

Validation | Validation History | Log

Ql [ 2]

Overview
Contextual Help Phase I: Science Proposal
1. Please ensure you and your co-Is are registered with J— — E—
the ALMA Science Portal Science Science Science Science
2. Create a new proposal by either: Goals Proposal Proposal

= Selecting File > New Proposal

» Clicking on the [l icon in the toolbar
» Or clicking on this link Importing
Click on the 8 proposal tree node and complete the
relevant fields.

Click on the overview steps to view the contextual help

@

i
Exporting




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

File Edit View Tool Search Help Perspective 1
a =& E [EHCIR~ IR

Project Structure [Editors

Proposal I Control and Performance

Unsubmitted Proposal

i Example 1
% i Proposal
% [ Planned Observing
¢ {8 ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
D

[} Technical Justification

(one set of
parameters
per SG)

Control and Performance

Configuration Information
Antenna Beamsize (1.13*A/D) 12m 16.613 arcsec

Number of Antennas 12m 43

ACA Tm configuration
Longest baseline 0.049 km
Synthesized beamsize 3.647 arcsec
Shortest baseline 0.009 km

Maximum recoverable scale 19.205 arcsec

These parameters are used to control various aspects of the observations, including the required antenna configurations and integration times.

7m  28.480 arcsec
m 10 T3
Most compact 12m configuration Most extended 12;
0.161 km 8.548 km
0.988 arcsec 0.029 arcsec
0.015 km 0.113 km

8.388 arcsec 0.414 arcsec

m configuration

Desired Performance

Desired Angular Resolution (Synthesized Beam)

Largest Angular Structure in source

Desired sensitivity per pointing

Bandwidth used for Sensitivity
Override OT's sensitivity-based
time estimate (must be justified)

Science Goal time estimate
(includes configuration and beam information
Simultaneous 12-m and ACA observations

Are the observations time-constrained?

@ single  Range > Any O standalone ACA
[o.00000 |
[Undefined |

[0.00000 ]

|AggregateBandwidth | +| Frequency width 7.500000 GHz

O Yes ® No

Time Estimate

) Yes ® No

quivalent to Infinity K

What do you
want?

Ql

]2

Validation | Validation History | Log

Overview

IS

@

Contextual Help
. Please ensure you and your co-Is are registered with
the ALMA Science Portal
. Create a new proposal by either:
= Selecting File > New Proposal
» Clicking on the [l icon in the toolbar
 Or clicking on this link
Click on the 8 proposal tree node and complete the
relevant fields.

Phase I: Science Proposal

Create

Validate
Science Science
0als Froposal

Submit
Science
Froposal

Click on the overview steps to view the contextual help

Importing

i
Exporting




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Eille Edit View Tool Search Help

Perspective 1

a =& E [EHCIR~ IR
Project Structure [Editors
Proposal I Control and Performance
Unsubmitted Proposal

% i Example 1
¢ Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

(one set of
<4— parameters
per SG)

Recommended

Ql

These p: are used to control various aspects of the observations, including the required antenna configurations and integration times.

Control and Performance

Configuration Information

Antenna Beamsize (1.13*A /D) 12m 16.613 arcsec 7m 28.480 arcsec

Number of Antennas 12m 43 7m 10 T 3

ACA 7m configuration Most compact 12m configuration  Most extended 12m configuration

Longest baseline 0.049 km 0.161 km 8.548 km

Synthesized beamsize 3.647 arcsec 0.988 arcsec 0.029 arcsec

Shortest baseline 0.009 km 0.015 km 0.113 km
Maximum recoverable scale 19.205 arcsec

8.388 arcsec 0.414 arcsec

Desired Performance
Desired Angular Resolution (Synthesized Beay

Largest Angular Structure in source

Desired sensitivity per pointing

3.00000

quivalent to 46.653 mK

What do you
want?

|AggregateBandwidth |~ | Frequency width 7.500000 GHz

O Yes ® No

Bandwidth used for Sensitivity
Override OT's sensitivity-based
time estimate (must be justified)

Science Goal time estim

i
(includes configuration and beam information) |__1IM® Estimate

Simultaneous 12-m and ACA observations. ®

Are the observations time-constrained? O Yes ® No

Feedback

]2

Validation | Validation History

Overview

Contextual Help

Phase I: Science Proposal

1. Please ensure you and your co-Is are registered with p— f—— —

the ALMA Science Portal Science Science Science Science
2. Create a new proposal by either: Goals Proposal Proposal

= Selecting File > New Proposal

» Clicking on the [l icon in the toolbar

 Or clicking on this link
3. Click on the & proposal tree node and complete the

relevant fields.

Click on the overview steps to view the contextual help

Importing

i
Exporting




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Eile Edit View Tool Search Help Perspective 1
Project Structure [Editors

Proposal ) Spectral | 5 Control and Performance
Unsubmitted Proposal me Estimate

o i Exampie 1 These p are used to control various aspects of the observations, including the required antenna configurations and integration times.

% i Proposal

Control and Performance
% [ Planned Observing

Note: The time in brackets is that required to reach the sensitivity.
Operational requirements often mean that the actual cbserved time

¢ {8 ScienceGoal (Science Goal 1) Configuration Information is longer, especially for mosaics. Please see the User Manual for more
8 GE?‘:'E‘ O n e Se O Antenna Beameize (113 <A/ D) 12m 16.613 arcsec 7m 28.480 arcsec B
Field setup

[} spectral Setup Number of Antennas 12m 43 7m 10 ™3 Input Parameters

[ Calibration Setup Requested sensitivity 3.000 mly

8o e e < ara m ete rS ACA 7m configuration Most compact 12m configuration Most extended 12m configuration Bandwidth used for sensitivity 7.500 GHz.

[) Technical Justification Longest baseline 0.049 km 0.161 km 8.548 km Representative frequency (sky, first source) oo
Synthesized beamsize 3.647 arcsec 0.988 arcsec 0.029 arcsec 2012

Estimated Total time for Science Goal -

Shortest baseline 0.009 km 0.015 km 0.113 km min

per SG)

Maximum recoverable scale 19.205 arcsec 8.388 arcsec 0.414 arcsec
Cluster 1

Source Name: RA Velocity (=
mis

Desired Performance
Desired Angular Resolution (Synthesized Beam) O Single ® Range () Any ©J Standalone ACA

[0.50000 = to [0.80000

Largest Angular Structure in source 5.0

Desired sensitivity per pointing 3.00000

Possible Configuration Combinations

quivalent to 46.653 mK @©0.800 " 12m (1) | 12m@2 | 7m s Nominal Beam(*) Max expected

None No 54 x

and 0.11943 K ®0.500" ‘

Bandwidth used for Sensitivity Frequency Width 7.500000 GHz . . .
Configurations are automatically selected

time estimate (must be justified) Input Parameters
Time Estimate

Science Goal time estimate Precipitable water vapour (all sources) 0.913mm (3rd Octile)
(includes configuration and beam informat|

Time required for 12m (1) [C43-2]

Simultaneous 12-m and ACA observations es W
Time on source per pointing (first source) 2.52 min [262.93 ms]

Are the observations time-constrained? O Yes ® No per pointing | ) o 1
Total number of pointings (al sources)
Number of tunings 1
Total time on scurce 5.04 min [525.87 ms]
Total calibration time 13.17 min
Other overheads 1.92 min (.
Total time for 1 SB execution 20.12 min
Number of SB executions 1
Total time to complete 5B 20.12 min
Calibration Breakdown per S8 execution
2 x Pointing 4.00 min
1 x Amplitude/bandpass 5.00 min
2 x Phase 60.00 5 =

Close
Feedback

Ql [ 2]

Validation | Validation History

Overview
Contextual Help Phase I: Science Proposal
1. Please ensure you and your co-Is are registered with E— = fE—
the ALMA Science Portal Science Science Science Science

2. Create a new proposal by either: Goals Proposal Proposal
« Selecting File > New Proposal
» Clicking on the [l icon in the toolbar
» Or clicking on this link Importing
3. Click on the & proposal tree node and complete the
relevant fields.

Click on the overview steps to view the contextual help
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Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

File Edit View Tool Search Help Perspective 1
Project Structure <[Edicors i )
Proposal ) Spectral | 5 Control and Performance
Unsubmitted Proposal
? These p: are used to control various aspects of the observations, including the required antenna configurations and integration times. Note: The time in brackets is that required to reach the sensitivity.
# lw Example 1 Operational requirements often mean that the actual observed time
S g,p‘m‘ . Control and Performance s longer, especilly for mossic. lase se the User anusl or more
% [ Planned Observing tails.
¢ (&) ScienceGoal (Science Goal 1) Configuration Information
D) General O n e Se O Antenna Beamsize ( 113 %A/D) 12m 16.613 arcsec 7m 28.480 arcsec Input Parameters
[ Field setup Requested sensitivity 3.000 mjy
[ spectral Setup Number of Antennas 12m 23 Im 10 T3 Bandwidth used for sensitivity 7.500 GHz
350.500
E Em:ra‘m’";:t:p a ra m ete rS ACA 7m configuration Most compact 12m configuration  Most extended 12m configuration Representative frequency (sky. first source) GHz
ontrol and Performance 4—
[} Technical Justification Longest baseline 0.049 km 0.161 km 8.548 km Estimated Total time for Science Goal 1.16 h
Synthesized beamsize 3.647 arcsec 0.988 arcsec 0.029 arcsec
rza|
pe r S G) Shortest baseline 0.009 km 0.015 km 0.113 km _
Source Name | RA | Dec | Velocity =
Maximum recoverable scale 19.205 arcsec 8.388 arcsec 0.414 arcsec OFS 108 [05:35:27.0606 [05:10700.408 170-000 km/s
= e ops_370 |-05: 3.778 [ 0.000 km/s
Desired Angular Resolution (Synthesized Beam) O Single ® Range () Any ©J Standalone ACA ‘
o500 e <] o fosoos Possible Configuration Combinations
. arcsec || to o,
Lm@ | 12m@ | 7m T Nominal Beam(®) | M2¢ Sxpected
Largest Angular Structure in source 15.00000
gesting a7 Wone e o 060 %071 s
Desired sensitivity per pointing 3.00000 quivalent to 46.653 mK @0.800 "
and 0.11943 K @0.500"
Bandwidth used for Sensitivity |AggregateBandwidth |~ | Frequency width 7.500000 GHz Input Parameters
Precipitable water vapour (all sources) 0.913mm (3rd Octile)
Override OT's sensitivity-based o
Yes @ No
time estimate (must be justified) T e (o B ()
Science Goal time estimate . Time on source per pointing (first source)  2.52 min [262.93 ms]
(includes configuration and beam information) T H T Tl 2 ) > B
Simultaneous 12-m and ACA observations O Yes @ No Number of tunings 1
Are the observations time-constrained? O Yes @ No ==l i 20 e EAO0) o [ o)
Total calibration time 13.17 min
Other overheads 1.92 min
Total time for 1 SB execution 20.12 min
Number of SB executions
Total time to complete SB 20.12 min
Calibration Breakdown per SB execution
2 x Pointing 4.00 min
1 x Amplitudefbandpass 5.00 min
2 x Phase 60.00 5
2 x Atmospheric 1.33 min
Calibration overheads 1.83 min
Additional Arrays.
ACA 7-m on-source time 24.19 min
Total 7-m time 49.76 min H
Feedback Total ACA time (max[t_7-m.t_TP]) 49.76 min  —
Q| J[n][wl[2 ]| | "Varigation | vaiidation History
; i total time for cluster 1 1.16 h
Overview LB
Contextual Help Phase I: Science Proposal
1. Please ensure you and your co-Is are registered with p— Jenaate L [ subm Close
the ALMA Science Portal Science ) Science Science Science
2. Create a new proposal by either: Goals Proposal /| Froposal
« Selecting File > New Proposal P, rons s
4 Seecting Pl o ool oA et e e ow we need also

 Or clicking on this link Importing
3. Click on the & proposal tree node and complete the
relevant fields.

i
Exporting




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Elle Edit View Tool Search Help Perspective 1

[@]g] (Gl (@]

Project Structure [Editors
Proposal " Spectral |5 Technical Justification
Unsubmitted Proposal
i Example 1
% i Proposal
% [ Planned Observing
¢ {8 ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup

[ Control and Performance
[0) Technical justification 4—

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.

sensitivity

Requested RMS over 7.500 GHz is 3.00 mjy. For a peak flux density of 1.00 mjy|, the S/N is 0.3

Achieved RMS over the total 7.500 GHz bandwidth is 125.15 ujy, 1.95 mK-4.98 MK For a continuum flux density of 1.00 mjy, 15.55 mK-39.81 mK , the achieved S/N is 8.0

Note that one or more of the /N estimates are < 3. Please double-check the RMS andjor line fluxes entered and/or address the issue below.
Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.
For line observations also justify the bandwidth used for the sensitivity calculation. u I I I l I I a ry O

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Requested Largest Angular Scale 15.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal

Correlator configuration

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
“You may want to consider spectral averaging to lower the data rate

Feedback
Validation | Validation History | Log

Ql [ 2]

Overview
Contextual Help Phase I: Science Proposal
1. Please ensure you and your co-Is are registered with E— = fE—
the ALMA Science Portal Science Science Science Science
Goals Froposal Froposal

2. Create a new proposal by either:
= Selecting File > New Proposal
» Clicking on the [l icon in the toolbar
» Or clicking on this link Importing
3. Click on the & proposal tree node and complete the
relevant fields.

Click on the overview steps to view the contextual help

i
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Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Elle Edit View Tool Search Help Perspective 1

a =& E [EHCIR~ IR
Project Structure [Editors

Proposal ] Spectral | & Technical Justification
Unsubmitted Proposal

i Eample 1 Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance

[} Technical Justification|

sensitivity

Requested RMS OVer 7.500 GHZ 15 3.00 mly. For & peak flux density of 1.00 mjy . the S/N 15 0.3

Achieved RMS over the total 7.500 GHz bandwidth is 125.15 ujy, 1.95 mK-4.98 MK For a continuum flux density of 1.00 mjy, 15.55 mK-39.81 mK , the achieved S/N is 8.0

Note that one or more of the /N estimates are < 3. Please double-check the RMS andjor line fluxes entered and/or address the issue below.
Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.
For line observations also justify the bandwidth sed for the sensitivity calculation. u I I I l I I ar O
[Bla, bla, bla, bla, bla, bla, bla, bl bla, bl bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,

la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla I |

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Requested Largest Angular Scale 15.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal
[B1, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
12, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Most justify

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
“You may want to consider spectral averaging to lower the data rate

.
Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, O' Ir SeIeCtIOn
la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Feedback
Validation | Validation History | Log

Ql [ 2]

Overview
Contextual Help Phase I: Science Proposal
1. Please ensure you and your co-Is are registered with E— = fE—
the ALMA Science Portal Science Science Science Science

2. Create a new proposal by either: Goals Proposal Proposal
= Selecting File > New Proposal
» Clicking on the [l icon in the toolbar
 Or clicking on this link
3. Click on the & proposal tree node and complete the
relevant fields.

Click on the overview steps to view the contextual help
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Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Perspective 1

Eile| Edit View Tool Search Help
New Proposal ur:w & m o |
Ctrl-D
[&) New DDT Proposal 4 \ / o
Spectral |5 Technical Justification
Open Project >
Open Project as New Proposal > Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.

(5] save ctrls Sensitivity
Save As...

Requested RMS over 7.500 GHz is 3.00 m)y For a peak flux density of 1.00 mJy , the S/N is 0.3
Use Project as Template »

o Validate CtriL Achieved RMS over the total 7.500 GHz bandwidth is 125.15 ujy. 1.95 mK-4.98 mK For a continuum flux density of 1.00 m]y, 15.55 mK-39.81 mK , the achieved S/N is 8.0
Submit Prifect Note that one or more of the S/N estimates are < 3. Please double-check the RMS and/or line fluxes entered and/or address the issue below.
Preferences curi-p Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.

Save Preferences
For line observations also justify the bandwidth used for the sensitivity calculation.
@iz [Bla, bla, bla, bla, bla, bla, bla, bl bla, bl bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla
Are we | 1app 2
y - Requested angular resolution 800.00 mas - 500.00 mas
. I Requested Largest Angular Scale [15.00 arcsec
I ets Va I ate M ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal
[B1, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
12, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla
Correlator configuration
Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
“You may want to consider spectral averaging to lower the data rate
Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla
Feedback
Q| J[n|[wl[2 ]| | "Varidation | vaiidation History | Log
Overview
Contextual Help Phase I: Science Proposal
1. Please ensure you and your co-Is are registered with J— — E—
the ALMA Science Portal Science Science Science Science
2. Create a new proposal by either: Goals Proposal Proposal
» Selecting File > New Proposal P oy e centestua ol
« Clicking on the Bl icon in the toolbar ick on the overview steps to view the contextual help
» Or clicking on this link e ——
3. Click on the 8 proposal tree node and complete the n
Exporting
Televant fields.




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Perspective 1

Eille Edit View Tool Search Help

[@]g] (Gl (@]

Project Structure

< Editors
Spectral | 5 Technical ustication

Proposal )
Unsubmitted Proposal

¢ Hy Example 1
¢ [ Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General

Red crosses
=== show where the
errors are

[} Technical Justification|

yours shouldn't
have errors)

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.
sensitivity

Requested RMS over 7.500 GHz is 3.00 mjy For a peak flux density of 1.00 mjy|, the S/N is 0.3

Achieved RMS over the total 7.500 GHz bandwidth is 125.15 ujy, 1.95 mK-4.98 mK
Note that one or more of the S/N estimates are < 3. Please double-check the RMS and/or line fluxes entered andjor address the issue below.

Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.
For line observations also justify the bandwidth used for the sensitivity calculation.

[Bla, bla, bla, bla, bla, bla, bla, bl bla, bl bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Requested Largest Angular Scale 15.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal
[B1, la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
12, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Correlator configuration

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.

“You may want to consider spectral averaging to lower the data rate

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

For a continuum flux density of 1.00 mjy, 15.55 mK-39.81 mK . the achieved S/N is 8.0

Validation | Validation History | Log

3 errors, 0 warnings : double-click on each row to be taken to the problem

Description

Suggestion

Select the top level Project node in the tree and fill in the Principal Investigator field

No Principal specifie

Select the proposal node in the Proposal tab and add your document

No reviewer has been defined

[2] ified
@ |No document found - you must add a Science Case to your proposal
[

[Please select a reviewer from the list of investigators

Q [l

Overview

Contextual Help
1. Please ensure you and your co-Is are registered with
the ALMA Science Portal
2. Create a new proposal by either:
« Selecting File > New Proposal
» Clicking on the [l icon in the toolbar
 Or clicking on this link
3. Click on the & proposal tree node and complete the
relevant fields.

Phase I: Science Proposal

Create Validate Submit
Science Scierce Science

0als Froposal Proposal

Click on the overview steps to view the contextual help

Importing

i
Exporting




Example 1. Continuum observations of several targets

ALMA Observing Tool (Cycle 8 2021 (MainCall-Phase1)) - Example 1

Eille Edit View Tool Search Help

[@]g]

(Gl (@]

Perspective 1

Project Structure
Proposal

[Editors
¥z

ectral

Technical Justification

Unsubmitted Proposal

% i Example 1
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance

[} Technical Justification|

Ready to submit!

Ql

N

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.

sensitivity

Requested RMS over 7.500 GHz is 3.00 mjy For a peak flux density of 1.00 mjy|, the S/N is 0.3

Achieved RMS over the total 7.500 GHz bandwidth is 125.15 ujy, 1.95 mK-4.98 MK For a continuum flux density of 1.00 mjy, 15.55 mK-39.81 mK , the achieved S/N is 8.0

Note that one or more of the S/N estimates are < 3. Please double-check the RMS and/or line fluxes entered andjor address the issue below.

Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.
For line observations also justify the bandwidth used for the sensitivity calculation.

[Bla, bla, bla, bla, bla, bla, bla, bl bla, bl bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Requested Largest Angular Scale 5.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal
[B1, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
12, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Correlator configuration

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
“You may want to consider spectral averaging to lower the data rate

bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, kla, bla, bla, bla, bla, bla, bla, bla,
bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Feedback
Validation | Validation History | Log

0 errors, 0 warnings

Description

Suggestion

" |No problems found |

Overview

Y

w

. Click on the

Contextual Help

. Please ensure you and your co-Is are registered with

the ALMA Science Portal

. Create a new proposal by either:

» Selecting File > New Proposal

= Clicking on the il icon in the toolbar

» Or clicking on this link

proposal tree node and complete the

relevant fields.

Phase I: Science Proposal

Create validate submit
Science Science Science

Proposal

Click on the overview steps to view the contextual help

Importin
g

Exporting




Example 1. Continuum observations of several targets

ALMA Observing Tool (Cycle 8 2021 (MainCall-Phase1)) - Example 1

Perspective 1

Eille Edit View Tool Search Help

[@]g]

(Gl (@]

Project Structure

[Editors

Spectral | 5 Technical ustication

Proposal )
Unsubmitted Proposal

% i Example 1
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance

[} Technical Justification|

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.
sensitivity

Requested RMS over 7.500 GHz is 3.00 mjy For a peak flux density of 1.00 mjy|, the S/N is 0.3

Achieved RMS over the total 7.500 GHz bandwidth is 125.15 ujy, 1.95 mK-4.98 MK For a continuum flux density of 1.00 mjy, 15.55 mK-39.81 mK , the achieved S/N is 8.0

Note that one or more of the S/N estimates are < 3. Please double-check the RMS and/or line fluxes entered and/or address the issue below.
Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.

For line observations also justify the bandwidth used for the sensitivity calculation.
Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Check Point!

ave your project now (aot file)

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
“You may want to consider spectral averaging to lower the data rate

bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, kla, bla, bla, bla, bla, bla, bla, bla,
bla, bla, bla, bla, bla, bla, bla, bla, bla, bla

Correlator configuration
2]

Feedback
Validation | Validation History | Log

relevant fields.

I 0 errors, 0 warnings
H Description I Suggestion
" |No problems found |
Q| A7
Overview
Contextual Help Phase I: Science Proposal
1. Please ensure you and your co-Is are registered with J— . E—
the ALMA Science Portal Science Science Geience
2. Create a new proposal by either: Proposal Proposal
» Selecting File > New Proposal P et e contestu ol
% Clicking on the I icon in the toolbar ik on the overview steps to view the contextual help
» Or clicking on this link IR
3. Click on the & proposal tree node and complete the é;‘pdn ing




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Eile| Edit View Tool Search Help Perspective 1

(il New Proposal ctr-N @@@ @

New DDT Proposal ctrl-D -

N Editors
° cment oa ! Spectral | 5 Technical Justification
Open Project 3
Open Project as New Proposal > Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.

(5] save ctrls Sensitivity
Save As...

ALMA Template Librar Requested RMS over 7.500 GHz is 3.00 m)y For a peak flux density of 1.00 mjy . the S/N is 0.3
Use Project as Template »

4 validate ctri-L Achieved RMS over the total 7.500 GHz bandwidth is 125.15 ujy. 1.95 mK-4.98 mK For a continuum flux density of 1.00 m]y, 15.55 mK-39.81 mK , the achieved S/N is 8.0
Submit Project Note that one or more of the /N estimates are < 3. Please double-check the RMS andor line fluxes entered and/or address the issue below.
SRR Submit Project o A Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.

Save Preferences
For line observations also justify the bandwidth used for the sensitivity calculation.
@iz [Bla, bla, bla, bla, bla, bla, bla, bl bla, bl bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla
Imaging
Requested angular resolution 800.00 mas - 500.00 mas
Requested Largest Angular Scale 5.0 arcsec
ustify the chosen angular resolution and largest angular scale for the source(s} in this Science Goal
[B1, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
1a, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla
Correlator configuration
[2]
Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
“You may want to consider spectral averaging to lower the data rate
Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
a, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla
Feedback
Q| (][] 2 ]| | Vaidation | Valigation Fistory | Log
Overview
Contextual Help Phase I: Science Proposal
1. Please ensure you and your co-Is are Tegistered with o p— TR | (e
the ALMA Science Portal Science Science Science
2. Create a new proposal by either: Proposal
» Selecting File > New Proposal P — . i
« Clicking on the B icon in the toolbar ick on the overview steps to view the contextual help
» Orelicking on this link [EenD (—
3. Click on the & proposal tree node and complete the And Library
Exporting
relevant fields.




Example 1. Continuum observations of several targets

ALMA Observing Tool (validation OT) - Example 1

Save Preferences

Submit Project to ALMA

Quit

Eile| Edit View Tool Search Help
Curl
(il New Proposal ctrin Ble| [&lnlo (&
New DDT Proposal ctrlD -
< Editors
Spectral | Spatial | Technical Justification
Open Project 3
Open Project as New Proposal » Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.
&l save Ctrl-s Sensitivity
Save As...
)
Requested RMS over 7.500 GHz is 3.00 mjy For a peak flux density of 1.00 mjy . the S/N is 0.3
Use Project as Template »
4 validate ctr-L Achieved RMS over the total 7.500 GHz bandwidth is 125.15 ujy. 1.95 mK-4.98 mK For a continuum flux density of 1.00 m]y, 15.55 mK-39.81 mK , the achieved S/N is 8.0
Submit Project Note that one or more of the /N estimates are < 3. Please double-check the RMS andor line fluxes entered and/or address the issue below.

Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.

For line observations also justify the bandwidth used for the sensitivity calculation.

bla,

[Bla, bla, bl. .
a, bla, bla, bla, bla,

bla,

bla, bla, bla

bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,

* Pl must submit

* Pl and co-Is get mail after submitting

* Re-submissions are possible at any time before deadline
(will overwrite the proposal in ALMA servers)

GEETy your correlator cet

"GP With particy 5 the numBer of sp:
You may want to consider spectral averaging to lower the data rate
Bla

CEral resolution elements per e wi

. bla,

bla, b.

1a, bla,

bla, bla, bla, bla, b

bla, b

bla, bla, bla,

bla, bla, bla, bla, bla, bla, bla, bla,
bla

Feedback

Ql

Ialv2

Validation | Validation History | Log

Overview

Contextual Help
1. Please ensure you and your co-Is are registered with
the ALMA Science Portal
2. Create a new proposal by either:
» Selecting File > New Proposal
= Clicking on the lll icon in the toolbar
 Or clicking on this link
3. Click on the & proposal tree node and complete the
relevant fields.

Phase I: Science Proposal

Create
Science

validate
Science
Froposal

Submit
Science

Click on the overview steps to view the contextual help

Importing
A g

Exporting




Example 1: Conti

nuum observations of several targets

Eile Edit View Tool Search Help

ALMA Observing Tool (Cycle 8 2021 (MainCall-Phase1)) - Example 1

Perspective 1
a = Eel - [EHCIR~ IR

Project Structure [Editors

Proposal ¥l spectra =l | Example1

Unsubmitted Proposal Principal Investigator

¥ i Example 1
¢ Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

Submitted
Proposal
(red label)

Ql

1PN

e

Main Project Information

Project
Assigned Priori
Project Code

iaz Rodriguez (ana.diazrodriguez@manchester.ac.uk) | Seleet P

Overview

Contextual Help
1. Please ensure you and your co-Is are registered with
the ALMA Science Portal
2. Create a new proposal by either:
= Selecting File > New Praposal
« Clicking on the il icon in the toolbar
» Or clicking on this link
3. Click on the & proposal tree node and complete the
relevant fields.

Phase I: Science Proposal

Create validate submit

Science Science Science
Proposal

Click on the overview steps to view the contextual help

Importin
g

Exporting




Example 1. Continuum observations of several targets

Eile Edit VieJ |Tool| Search Help

ALMA Observing Tool (Cycle 8 2021 (MainCall-Phase1)) - Example 1

a ALMA LO Configuration Tool... 7]
(8] Sensitivity Calculator...

Project Struc

Perspective 1
< [Editors
(€] Display Project Time Summary

Example 1

Principal Investigator
Show Printable Summary of Proposal and Science Goals
Generate a PDF of Whole Proposal

iaz Rodriguez (ana.diazrodriguez@manchester.ac.uk) | Select Pi
—_—
[Generafe 2 PDF of Whole | Main Project Information
[} Field setup.
[ spectral Setup : Project Example 1
Assigned Priority
E Cabraton setup : Project Code None Assigned
[} Technical Justification

Ql

al~]2
Overview

Contextual Help

Phase I: Science Proposal
1. Please ensure you and your co-Is are registered with

New Create Validate Submit
the ALMA Science Portal Science Science Science
2. Create a new proposal by either: G

o0als Proposal Proposal
= Selecting File > New Praposal

= Clicking on the il icon in the toolbar
= Or clicking on this link

Importing
3. Click on the & proposal tree node and complete the And
- Exporting
relevant fields.

Click on the overview steps to view the contextual help




Example 1. Continuum observations of several targets

c-1
Example 1 None Assigned son
NS
ALMA .
None Assigned
ABSTRACT SG:1of1  Science Goall  Band 7
Bla bla Blabla
Science Goal Parameters
H Ang Res s | Requested RMS RIS Bandwidin Rep.Freq Cont. RIS Cont. Bandwidtn Poin.Prod
0 I n O a 0 u e ro Osa e a' ' l 0.8000" - 0.50007 5.0 3 mdy, 46.7 MK-119.4 MK §414.96 ks, 7.5 GHz 350.500000 GHz | 125.144 ply, 1.9 mK-5 mK 7.500 GHz XYY
Use of 12m Array (43 antennas)
t_total(all configs) | 1 science(C43-2) | Ltotall) Imaged area #12m pointing 12m Mosaic spacing | HPBW Lper_point Data Vol Avg. Data Rate
0.3 oin 0.0n 55 I 2 I offset 166 15115 1sce 19 meis
Use of ACA 7m Array (10 antennas) and TP Array
t_total(AGA) t_total(7m) t_total(TP) Imaged area #7m pointing 7m Mosaic spacing | HPBW L_per_paint Data Vol Avg. Data Rate
| |
Spectral Setup : Single Continuum
oy rrea Senter Freqs. e Bandwidth Resolution Vel. Bandwidth Vel. Resolution RMS
ISM, star formation and astrochemistr 343.500000 336.500000 128 1875.00 MHz 31.250 MHz 1670.5 km/s 27.841 kml/s 24131 Jdy, 10.4 mK
SCIENCE CATEGORY: y 338.500000 128 1675.00 MHz 31.250 MHz 1660.6 kmJs 27.677 kmis 238.01 yly, 10.2 mK
348.500000 128 1875.00 MH2 31.250 MHz. 1612.9 km/s 26.882 km/s. 246.24 pJy, 9.9 mK.
ESTIMATED 0.3 h ESTIMATED 0.0 h ESTIMATED 0.0 h 350.500000 128 1875.00 MHz. 31.250 MHz 1603.7 kmls 26.729 kmls 251.2 ply, 10.0 mK
12-M TIME: . 7-M TIME: . TP TIME: . 2 Targets Expected Source Properties
DUPLIGATE OBSERVATION PeakFIus | SR |Lnewidin| o, 1/ ewioin}used o senstiy | ol e
JUSTIFICATION: No Target RaDec (ICRS) Vdst.frame --OR--z Gine | 000wy oo | okmis 0% 0.0
1 [1HOPS_108 05:35:27, -05:10:00 ‘ 0,00 ks 51k RADIO ‘ Gontnaim | Toomyy | 8.0 oo 0o
REPRESENTATIVE SCIENCE GOALS (UP TO FIRST 30) 2 [z-hops 370 05:35:27, -05:09:33 0.00 km/s,lsr,RADIO Dynamic range (cont flux/line rms): N/A
SCIENCE GOAL POSITION | BAanD | ANG.RES.(") [ tas.(y) [ aca?
Science Goal 1 ICRS 05:35:27.0696, -05:10:00.408 | 7 | 0.800-0.500 | 5.000 | N
[Total # Science Goals : 1 B .
[ SCHEDULING TIME CONSTRAINTS | NONE | TIME ESTIMATES OVERRIDDEN 2 I No S hare P D F (and aot fl Ie) Wlth ‘ O_ P I S
SG-1

Science Case

Testing

Testing

Sensitivity Comments

Note that one or more of the S/N estimates are < 3. Please double-check the RMS and/or line fluxes entered and/or address the issue below.
Justification for requested RMS and resulting S/N (and for spectral lines the bandwidth selected) for the sensitivity calculation

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla
Justification of the chosen angular resolution and largest angular scale for the source(s) in this Science Goal

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla
Justification of the correlator set-up with particular reference to the number of spectral resolution elements per line width.

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla




Lets propose!

Example 2: Line observations of single target (e.g. study
kinematics of a protostellar disk)

e 1 Science Goal with 1 target

To do:
1) Open template created before

2) Add Science Goal
3) Fill in General and Source Setup fields

4) Save it as Example 2



Example 2: Line observations of single target

Eille Edit View Tool Search Help

(Gl (@]

ALMA Observing Tool (validation OT) - Example 2

Perspective 1

Project Structure

Proposal | Pr

[Editors

Field Setup

Unsubmitted Proposal

Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)

[ General

[ Field setup
[ spectral Setup
[ calibration Setup

[ Control and Performance
[} Technical Justification

Ql

a2

Spatial Image

(8]} 4(O)(m]

@ [1x |
05:35:27.336, -05:06:59.17 (j2000)
Image Filename [.jsky3/cache/jsky318179622349510000L fits

303, 451 [ 11498.0

‘@\@\EI

FOV Parameters

=)

Representative Frequency (Sky) 345.796 GHz
Antenna Diameter ® 12m

Antenna Beamsize (HPBW) 16.840 arcsec
Show Antenna Beamsize

Image Query

=
Image Server |Digitized sky (Version 11} at ESO [~]

HOPS 370

Source

=

Source Name HOPS 370

| Resove |

Choose a Solar System Object? []

Sexagesimal

Parallax [0.00000
PMRA [0.00000
PM DEC [0.00000

Source Coordinates

source Radial Velocity

Target Type

Expected Source Properties

Peak Continuum Flux Density per Synthesized Beam [1.00000 [~
Continuum Linear Polarization 0.0 per cent
Continuum Circular Polarization Y — per cent

Peak Line Flux Density per Synthesized Beam

Line Width
Line Linear Polarization

—— per cent
0.0 per cent

Line Circular Polarization

Field Center Coordinates

Coord Type @ Relative O Absolute

Name of object [Unspecified

il in
nfo

EE

Offset Unit [arcsec [+
#Pointings 1
RA [arcsec] [ Dec [arcsec]
0.00000 [0.00000
[ ndd ][ Delte | [_mport ][ export |
Add Source || Load from File... |[ ExporttoFile.. || Clonesource || Deletesource ||




Example 2: L

Eille Edit View Tool Search Help

(Gl (@]

Ine observations of single target

ALMA Observing Tool (validation OT) - Example 2

Perspective 1

Ql

a2

® spectral Line
© single Continuum

e

Spectral Type
 spectral Scan

Produce image sidebands (Bands 9 and 10 only) []
Polarization products desired O XX @ DUAL ) FULL
Spectral Setup Errors

No spectral window in the list.No suitable receiver band for the range 0.0 GHz, 0.0 GHz]

Spectral Line

Baseband-1
Fraction Centre Freg Centre Freq Spec. Representative
e ‘ Toky:bor) Transition Bandwidth, Resolution (smoothed) s =g
l| | Add spectral window centred on a spectral ine | | Ddd spectral window manually |[ Delete | [ show image
Baseband-2
Add spectral window centred on a spectral ine | [ Add spectral window manually |[ Delete | [JShow image ow
Baseband-3
Add spectral window centred on a spectraline | [ Add spectral window manually || Delere | [ show image spectral windows
Baseband-4
Add spectral window centred on a spectral ine | | _Add spectral window manually |[ Delete | [ show image ow

Representative Frequency

The representative frequency is used in conjunction with the sensitivity entered on the ‘Control and Performance’ page to estimate the required

Project Structure 4[Editors
Proposal | Program Spectral | Spatisl | Spectral Setup
Unsubmitted Proposal 100j0000 200/0000 . 300{0000 __ 400J0000 50000000 500{0000 . 700{0000, 200/0000 . 900/0000 1000, |4]
7 i Example 2 03 05 06 07 [
i Proposal
% [ Planned Observing
% (&) ScienceGoal (Science Goal 1)
[ General —
[ Field setup
[) spectral Setup 4—
[ calibration Setup
[ Control and Performance
[} Technical Justification
100/0000 200l0000 300/0000 400J0000 50010000 600l0000 700]0000 200/0000 900/0000 1000]
Rest Frequency (GHz)

Overlays: Receiver Bands Transmission DSB Image [] Spectral Lines| Select Lines to Overlay.

Water Vapour Column Density: @ Automatic Choice (+ Manual Choice [5.186mm (7th Octie) | - |

Viewport: to on | zoomtoBand |  meser |

Spectral Type
EE




Example 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2

Elle Edit View Perspective 1

Create spectral windows centred on spectral |

Project Structure| Transition Filter

Proposal | Pr "

fTransitions matching your filter settings:
(double-click column header for primary sort, single-click subsequent columns for secondary sorting. Single clicks will reverse sort order of already selected columns.)

J
k IR oo CO"2-1" or*aido™ Transition ~ Description Rest Frequency & Sky Frequency pper-state Energy. Lovas Intensity Catalog [ ] 1000 2]
Example 2 Include description Ic: 5/2-33/2, Q= 4-Pentadiynylidyne 1108238 GHz 1103183 GHz 474017 Offine
v i Proposal 5/2-33/2, 0= 4 Pentadiynylidyne .108396 GHz .103344 GHz 4.7425.3 Offline
% CIPlanne Erequency Filters 4-Pentadiynylidyne 110087 GHz 05032 GHz 401.6 Offline
%Sl A MA Band .4-Pentadiynylidyne 1110244 GHz 05189 GHz 425.3 Offline
0O L 0=172, ,3-Butadiynyl radical 1123003 GHz 117948 GHz 1K 21[12.771 1 Offline il
ol @ o) 1(0,11)-10(1,10) thyl Cyanide 151838 GHz 46781 GHz 02K 0.110.328 0 Offline
B 3 4 5 6 7 8 9 10 11(10,1)11(1L,0) ethanol 158571 GHz 53513 GHz 1066.119 K 1.450 O Offine
UNIDENTIFIED .163000 GHz 57942 GHz Offline
D} sky Frequency (GHz) S0 v=1 21 silicon Monoxide 1164253 GHz 1159195 GHz 1753.828 K [Offline
A H13CCCH 2(1,2)1(0,1) Cyclopropenylidene 185621 GHz 180562 GHz 6331 K Offline.
) [ 4215 NIDENTIFIED 215000 GHz .200030 GHz Offine
Min [ 313 Max [ 950 CN v8=1) =36-36, K =3-1 ethyl Cyanide 271390 GHz 266326 GHz 1139.034 K Offline 0l
v=0 32(5,27)-31(6,26} ulfur dioxide -320876 GHz -315809 GHz 549.36 K Offline ol
Receiver/Back End Configuration 4356 NIDENTIFIED .356000 GHz .350030 GHz Offine.
O Allines U-84385 NIDENTIFIED .385000 GHz .370020 GHz Offine
450 2(2)-1(1) ulfur Monoxide .410690 GHz .405617 GHz 19.233 K Offline
@ Potentially selectable lines CH3OH v £=0 13(-3,11)-14(2,13) ethanol -423776 GHz -418702 GHz 273.808 K Offline
O Lines in defined spws 13CH30H v £=0 13(3,11)12(4,9) ethanol .444140 GHz .439065 GHz 269.033 K Offine. =
Filtering unobservable lines ETIEE ol
Upper-state Energy (K) Spectral windows in this baseband (maximum of four) =E
Min [ of max | Transition = Description Rest Frequency & Sky Frequency

Molecule Filter / Environment
Show [all atoms and molecules

Can't find the transition you're looking for in.
the offine pool? Find more in the online:
splatalogue.

[ Search Online ]

[ Rese Filters ]

ntative
How

The spectral line
selector tool

The representative frequency is used in conjunction with the sensitivity entered on the ‘Control and Performance’ page to estimate the required
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Example 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2

File Edit View Perspective 1
Create spectral windows centred on spectral |

Project T /I?aném on Filter fTransitions matching your filter settings: B

Proposal B (double-click column header for primary sort, single-click subsequent columns for secondary sorting. Single clicks will reverse sort order of already selected columns.)

(=t bmit fed oy Transition = Description uency & Sky Frequency I Upper-state Energy Lovas Intensity Catalog L 1000 4
L ’E“"“"EZ 32 Carbon Monoxide Hz 339.479124 GHz |6161.831K Offine
v i Proposal 32 Carbon Monoxide Hz 342627064 GHz 3116.561 K Offine
# CIPlanng Frequency Filters 32 Carbon Monoxide Hz 2 33.102K Offine
¢S ) A Band 32, F=5/2-3/2 Carbon Monoxide lon Hz iz Offline
0O n 32, F=7/2:5/2 Carbon Monoxide lon Hz iz offiine =
0O T N T
0 3 4 5 6 8 9 10
O] sky Frequency (GHz) - -
B -
ol T T T

Min 275 Max 373]
00]

Receiver/Back End Configuration

O Alllines

@ [Potentially selectable lines

O Lines in defined spw:
Filtering unobservable lines Add te ectral t

Upper-state Energy (K) Spectral windows in this baseband (maximum of four) EE
Min - [ o max | Transition ~ Description Rest Frequency - Sky Frequency

Molecule Filter / Environment
Show [all atoms and molecules

Can't find the transition you're looking for in.
the offine pool? Find more in the online:
splatalogue.

[ Search Online ]

[ Rese Filters ]

ntative
How

The representative frequency is used in conjunction with the sensitivity entered on the ‘Control and Performance’ page to estimate the required
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Example 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2

File Edit View Perspective 1
Create spectral windows centred on spectral |

Project T /mm on Filter fTransitions matching your filter settings: B

il i (double-click column header for primary sort, single-click subsequent columns for secendary sorting. Single clicks will reverse sort order of already selected columns.)
Upper-state Energy | Lovas Intensity Sij 2
192 K | 70[0.036 D*

Unsubmitted Propo
¥ i Example 2
¢ [ Proposal
% CIPlanne  Frequency Filters.
+ Sl 5 MA Band

Catalog L 1000 4

ine

Transition = | Description | Rest Frequency < | Sky Freguency
COv=032 |Carbon Monoxide 1345.795920 GHz 1345.775208 GHz

Available lines to
— observe e

Receiver/Back End Configuration

DooDDoD
H
2
=
B
g
2
:

O Alllines
® Potentially selectable lines
Q Lines in defined spw
© Filtering unobservable lines T
Upper-state Energy (K) Spectral windows in this baseband (maximum of four) EE
Min - [ o max | Transition ~ T Description T Rest Frequency - I Sky Frequency
COv=03-2 |Carbon Monoxide 1345.795990 GHz 1345.775208 GHz

Molecule Filter / Environment
Show [all atoms and molecules

Can't find the transition you're looking for in.
the offine pool? Find more in the online:
splatalogue.

[ Search Online ]

— Selected lines

ntative
How

The representative frequency is used in conjunction with the sensitivity entered on the ‘Control and Performance’ page to estimate the required
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Example 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2

Eile Edit View

Project Structur
.

Proposal

Unsubmitted Propot

% lw Example 2
% imr Proposal

% (3 Planne

¢ 8 Sci

oopood

/l‘ranémnn Filter

Frequency Filters
ALMA Band

Sky Frequency (GHz2)

Receiver/Back End Configuration
Alllines

® Potentially selectable lines

O Lines in defined spws

© Filtering unobservable lines

Upper-state Energy (K)
Min o mMax o
Molecule Filter / Environment

Show [all atoms and molecules

Can't find the transition you're looking for in.
the offine pool? Find more in the online:
splatalogue.

[ Search Online ]

[ Rese Filters ]

Perspective 1
Create spectral

indows centred on spectral |

fTransitions matching your filter settings:

(double-click column header for primary sort, single-click subsequent columns for secondary sorting. Single clicks will reverse sort order of already selected columns.)

Transition = Description t Frequency & Sky Frequency I Upper-state Energy Lovas Intensity sij 2 I Catalog
502 v2=124(2,22)-23(3,21) ulfur dioxide 1923751 GHz .903082 GHz 1057.883K [offline
50 35 v=0 8(8)-7(7) ulfur Monoxide 1310612 GHz 9920 GHz 87.482 Offline
502 v=0 5(5.1):6(d,2) ulfur dioxide .148071 GHz 8228 GHz [75.144 Offline
013(2,12)-12(1,11) ulfur dioxide 38538 GHz 7784 GHz [02.984 Offline

V=0 62(16,46)-63(15,49) ulfur dioxide .338778 GHz 318024 GHz 24182 Offline M
7 ulfur dioxide 48984 GHz 428223 GHz 520096 K Offline
1)-34(2,32) ulfur dioxide 365261 GHz 344446 GHZ 1352.760K Offiine
9)-18(0,18) ulfur dioxide 379185 GHz 358368 GHZ [230.6 K Offline
,12)-16(3,13} ulfur dioxide 523878 GHz 503053 GHz 164.464 K Offline
.14)-18(3,15) uffur dioxide 501787 GHz 570057 GHz 960.78 K Offiine
)-18(0,18) ulfur dioxide 652160 GHz 631336 GHZ [168.138 K Offiine
Available li t
observe e

ntative
How

Add to spectral window list

Spectral windows in this baseband (maximum of four)

Transition =

Description I Rest Frequency = sky Frequency

345.795990 Gz 345.775208 Gz

Selected lines

Ql

The representative frequency is used in conjunction with the sensitivity entered on the ‘Control and Performance’ page to estimate the required




Eile Edit View

Example 2: Line observations of single target

Project Structur

mlnnn Filter

% imr Proposal
% (3 Planne
¢ 8 Sci

oopood

Frequency Filters
ALMA Band

R

Sky Frequency (GHz)

Receiver/Back End Configuration
Alllines

® Potentially selectable lines

O Lines in defined spws

© Filtering unobservable lines

Upper-state Energy (K)
Min o mMax o
Molecule Filter / Environment

Show [all atoms and molecules

Can't find the transition you're looking for in.
the offine pool? Find more in the online:
splatalogue.

[ Search Online ]

[ Rese Filters ]

ALMA Observing Tool (validation OT) - Example 2

Create spectral windows centred on spectral |

fTransitions matching your filter settings:
(double-click column header for primary sort, single-click subsequent columns for secondary sorting. Single clicks will reverse sort order of already selected columns.)

Perspective 1

Transition = Description t Frequency & Sky Frequency Upper-state Energy Lovas Intensity sij 2 I Catalog

502 v2=124(2,22)-23(3,21) ulfur dioxide 1923751 GHz .903082 GHz K [offline
2l wlfur Moo 0zig 10612 Gil %n
ECCRINTE) Lt 28971 128208 G o
V=0 13(2,12)-12(1,11) ulfur dioxide 38538 GHz 317784 GHz Offline

ulfur dioxide 338778 GHz 318024 GHz Offline M
ulfur dioxide 48984 GHz 428223 GHz Offline
ulfur dioxide 365261 GHz 344446 GHz Offiine
ulfur dioxide 379185 Ghz 358368 GHzZ ¥ Offline
,12)-16( ulfur dioxide 523878 GHz 503053 GHz 1 Offline
.14)-18(3,15) uffur dioxide 501787 GHz 570057 GHz 960.78 K Offiine
)-18(0,18) ulfur dioxide 652160 GHz 631336 GHZ [168.138 K Offiine

Available li t
observe e

Add to spectral window list

Spectral windows in this baseband (maximum of four)

ntative
How

502 v=05(5,1)-6(4,2] 345148971 GHz

[as.12828 oriz

.
r
[Sulfur dioxide
[

0v=032 [345.795000 GHz

1345.775208 GHz

Selected lines

cance( |

Ql

The representative frequency is used in conjunction with the sensitivity entered on the ‘Control and Performance’ page to estimate the required




ample 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2

Elle Edit View Tool Search Help Perspective 1

(Gl (@]

Project Structure 4[Editors
Proposal | Pre

Spectral Setup

Unsubmitted Proposal
% i Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[} spectral Setup 4—
[ calibration Setup
[ Control and Performance
[} Technical Justification

Visualisation

In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other.

Leftrright click to zoom in/out, grab siiding bar to pan
Note: Moving LOL here is for experimentation only - actual setup determined by the windows.

Observed Frequency (GHz)
448000 345/0000 345/2000 345/4000

345|6000 345|8000 346|0000

502 u=0 5(5,1)-6(4,2)

00 3aslo000 345]2000 34slag00 3asl6000 345]8000 34610000

Rest Frequency (GHz)
DSB Image [] Spectral Lines| Select Lines to Overlay
Water Vapour Column Density: @ Automatic Choice (O Manual Choice 1.262mm (4th Octile)

Viewport: Pan to Spectral Window | ZoomtoBand |  Reset |

Transmission

Overlays:

Receiver Bands.

Spectral Type

® Spectral Line
Spectral Type © single Continuum
O spectral Scan

Produce image sidebands (Bands 9 and 10 only) []

Polarization products desired O XX ® DUAL O FULL
Spectral Setup Errors
Baseband-1 : Bandwidth and channel spacing must be set to all spectral windows.
Spectral Line
- Baseband-1
S pe‘ tra WI l l OWS Fraction ‘ Centre Freg ‘ Centre Freq | N ‘ - ‘ Spec. ‘ Representative —
) o T a T T = T
2 1345.14897 GHz 1345.11902 GHz 5(5.1)-6(4,2) |Please select a correlator mode n 0l
- I I I ] 72 [345.79599 GHz [345.76598 GHz 03-2 [Please select a correlator mode. n (]
Add spectral window centred on a spectral inel | | Add spectral window manually |[ Delete | [JShow image ow
Baseband-2
Add spectral window centred on a spectraline | [ Add spectral window manually || Delere | [ show image spectral windows
Baseband-3
Add spectral window centred on a spectral ine | | _Add spectral window manually |[ Delete | [ show image

Baseband-4
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(Gl (@]

ALMA Observing Tool (validation OT) - Example 2

Perspective 1

Project Structure

Proposal | Program

[Editors

Spectral Setup

Unsubmitted Proposal

Example 2

% i Proposal

% [ Planned Observing

¢ (8] ScienceGoal (Science Goal 1)

[ General
[ Field setup
[ spectral Setup 4—
[ calibration Setup
[ Control and Performance
[} Technical Justification

Ql

a2

Visualisation

In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other.

Leftrright click to zoom in/out, grab siiding bar to pan

Note: Moving LOL here is for experimentation only - actual setup determined by the windows.

Observed Frequency (GHz)
345/4000

44J8000 345|0000 345/2000 345|6000 345|8000

Spw bandwidth

502 v=0 5(5,1)-6(4.2)

lcov=032

346|0000

00 3aslo000 345]2000 34slag00 3asl6000 34518000

Rest Frequency (GHz)
Overlays: DSB Image [] Spectral Lines| Select Lines to Overlay
Water Vapour Column Density: @ Automatic Choice (O Manual Choice 1.262mm (4th Octile)

Viewport: Pan to Spectral Window | ZoomtoBand |  Reset |

Receiver Bands.

Transmission

Spectral Type

® Spectral Line
Spectral Type © single Continuum

O spectral Scan

Produce image sidebands (Bands 9 and 10 only) []
Polarizatien products desired O XX @ DUAL O FULL
spectral Setup Errors

spectral Line

34610000

Baseband-2

Baseband-1
Fraction Centre Freg Centre Freq Spec. Representative
i oyban Transition Bandwidth, Resolution (smoothed) s e
/2 345.79599 GHz 345.76598 GHz 32 234.375 MHz{ 203 km/s), 282.227 kHz( 0.245 km/s) 2 -
11/2 345.14897 GHz 345.11902 GHz. 5(5.1)-6(4.2) 234.375 MH2(_ 204 km/s), 282.227 kHz( 0.245 km/s) 2 Q
Add spectral window centred on a spectral ine_| | _Add spectral window manually |[ Delete | [ show image spectral windows

Add spectral window centred on a spectral line

Add spectral window manually | |

Baseband-3

Add spectral window centred on a spectral ine

Add spectral window manually |[ Delere | [ show image s

Baseband-4
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ALMA Observing Tool (validation OT) - Example 2

Elle Edit View Tool Search Help Perspective 1

(Gl (@]

Project Structure 4[Editors
|( Proposal | Pr ] I
Unsubmitted Proposal
Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[} spectral Setup 4—
[ calibration Setup
[ Control and Performance
[} Technical Justification

Spectral Setup

Visualisation

In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other.

Leftrright click to zoom in/out, grab siiding bar to pan
Note: Moving LOL here is for experimentation only - actual setup determined by the windows.

Observed Frequency (GHz)
448000 345/0000 345/2000 345/4000

345|6000 345|8000 346|0000

502 v=0 5(5,1)-6(4.2)

lcov=032

00 3aslo000 345]2000 34slag00 3asl6000

Rest Frequency (GHz)
[] spectral Lines| Select Lines to Overlay
1.262mm (ath octile) | - |

Viewport: Pan to Spectral Window | ZoomtoBand |  Reset |

34610000

Overlays: Receiver Bands

Transmission

Water Vapour Column Density: ® Automatic Choice () Manual Choice

Spectral Type

visualize lines

® Spectral Line
Spectral Type © single Continuum
O spectral Scan

Produce image sidebands (Bands 9 and 10 only) []

Polarization products desired O XX @ DUAL O FULL

Spectral Setup Errors

Spectral Line

Baseband-1

Fraction Centre Freg Centre Freq Spec. Representative
i oyban Transition Bandwidth, Resolution (smoothed) s e L

/2 345.79599 GHz 345.76598 GHz 32 234.375 MHz{ 203 km/s), 282.227 kHz( 0.245 km/s) 2 -

11/2 345.14897 GHz 345.11902 GHz. 5(5.1)-6(4.2) 234.375 MH2(_ 204 km/s), 282.227 kHz( 0.245 km/s) 2 Q

Add spectral window centred on a spectral ine_| | _Add spectral window manually |[ Delete | [ show image spectral windows

Baseband-2

Add spectral window centred on a spectral line

Add spectral window manually | |

Baseband-3

Add spectral window centred on a spectral ine

Add spectral window manually |[ Delere | [ show image s

Baseband-4
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Example 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2

Eile Edit View Perspective 1
overlay

Project Structure| Transition Filter fTransitions matching your filter settings: B
=] (double-click column header for primary sort, single-click subsequent columns for secondary sorting. Single clicks will reverse sort order of already selected columns.)

[ Prood [carbon= 4
Unsubmitted Propos .o cov2.1% or "oxide

Transition = Description Rest Frequency = I Upper-state Energy Lovas Intensity Sij p* Catalog =
v ’E:@"‘P‘EZ Include description arbon Monosulfide 836 K 26.836 D* Offline I
v i Proposal arbon Monosulfide 322.083K 26.237 D* Offline
7 E3Panng  Frequency Filters arbon Line K il
¢Sl ) ma pand arbonyl Suffide 47.67 K 0.6/14.842 D* Offline
[} n arbon Monoxide |345.795990 GHz 1345.795990 GHz 3.192 K 70/0.036 D* Offline
O v arbon Line 1346.931502 GHz 1346.931502 GHz K Offline
D sky Frequency (GHz2)
B
ol T 555000000000
1 tax H
Receiver/Back End Configuration
Alllines
® Potentially selectable lines
O Lines in defined spws
© Filtering unobservable lines

Upper-state Energy (K)
Min o mMax o
Molecule Filter / Environment

show [all atoms and molecules
EE

Can't find the transition you're looking for in.
the offine pool? Find more in the online:
splatalogue.

[ Search Online ]

[ Rese Filters ]

ntative
dow

(___ 4dd to selected Transiions )

Selected Transitions ~— —

Transition = Description = | Rest Frequency = sky Freguency

Ql
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ALMA Observing Tool (validation OT) - Example 2

Eile Edit View Perspective 1
overlay
Project Structure| Transition Filter fTransitions matching your filter settings: B
Proposal | Progra [carbon= 4 | (double-click column header for primary sort, single-click subsequent columns for secendary sorting. Single clicks will reverse sort order of already selected columns.)
[AERIEERNN = o CO=2 1= oroxin Transition = Description Rest Frequency = I Upper-state Energy Lovas Intensity Sij p* Catalog =
v - ’E:@"‘P‘EZ Include description arbon Monosulfide 836 K 26.836 D Offline ||
¢ i Proposal arbon Monosulfide 322.083K 26.237 D* Offline
T ﬁP\alnne Frequency Filters arbon Line K Offline
¢Sl ) ma pand arbonyl Sulfide 47.67 K. 0.6[14.842 D* Offine
[} n arbon Monoxide |345.795990 GHz 1345.795990 GHz 3.192 K 70/0.036 D* Offline
0 N CENy arbon Line |336.931502 GHz [346.931502 GHz K Offine
O sky Frequency (GHz2)
B
ol T 555000000000

Receiver/Back End Configuration
Alllines

® Potentially selectable lines

O Lines in defined spws

© Filtering unobservable lines

Upper-state Energy (K)
Min o mMax o
Molecule Filter / Environment

show [all atoms and molecules
EE

Can't find the transition you're looking for in.
the offine pool? Find more in the online:
splatalogue.

[ Search Online ]

[ Rese Filters ]

ntative
dow

lAdd to Selected Transitions

Selected Transitions

Transition = Description =
arbon Monosulfide

on Monosulfide

on Recombination Line

onyl sulfide

on Monoxide

on Recombination Line [346.931

Selected lines

Rest Frequency = Sky Frequency

1345.795990
[346.931502

SN ES

C37y

Hinn

Ql
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ALMA Observing Tool (validation OT) - Example 2

Elle Edit View Tool Search Help Perspective 1

(Gl (@]

Project Structure 4[Editors
|( Proposal | Pr I
Unsubmitted Proposal
Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[} spectral Setup 4—
[ calibration Setup
[ Control and Performance
[} Technical Justification

Spectral Setup

Visualisation

In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other.

Leftrright click to zoom in/out, grab siiding bar to pan
Note: Moving LOL here is for experimentation only - actual setup determined by the windows.
Observed Frequency (GHz)
330{0000 335/0000 340jo000 345/00(

00 350/0000 355J0000 360]0000

3 L Is02|u=0 5(s}16(42)
lcov-032
330l0000 33500000 340]0000 aaﬁkmm: 35000000 355l0000 360l0000
Rest Frequency (GHZ
Overlays: Receiver Bands Transmission DSB Image (] Spectral Lines| _Select Lines to Overlay

Water Vapour Column Density: ® Automatic Choice ( Manual Choice|1.262mm (4th Octile)

Viewport: Pan to Spectral Window | ZoomtoBand |  Reset |

Spectral Type

® Spectral Line
Spectral Type © single Continuum
O spectral Scan

Produce image sidebands (Bands 9 and 10 only) []

Polarization products desired O XX @ DUAL O FULL

Spectral Setup Errors

Spectral Line

Baseband-1

Fraction Centre Freg Centre Freq Spec. Representative
i oyban Transition Bandwidth, Resolution (smoothed) s e L

/2 345.79599 GHz 345.76598 GHz 32 234.375 MHz{ 203 km/s), 282.227 kHz( 0.245 km/s) 2 0]

11/2 345.14897 GHz 345.11902 GHz. 5(5.1)-6(4.2) 234.375 MH2(_ 204 km/s), 282.227 kHz( 0.245 km/s) 2 Q

Add spectral window centred on a spectral ine_| | _Add spectral window manually |[ Delete | [ show image spectral windows

Baseband-2

Add spectral window centred on a spectral line

Baseband-3

Add spectral window centred on a spectral ine

Baseband-4
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ALMA Observing Tool (validation OT) - Example 2

EAFPIA] Perpecine 3

Eille Edit View Tool Search Help

Project Structure

«[Edicors
|("Proposal | 7 Spectral | Spatisl | Spectral Setup
Unsubmitted Proposal Visualisation
Example 2
¢ i Proposal In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
4 £ Planned Observing Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
T L&) ScienceGon! (Science Goal 1) Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other.
[) General Leftrright click to zoom in/out, grab siiding bar to pan
[ Field setup Note: Moving LOL here is for experimentation only - actual setup determined by the windows.
[ spectral setup 4_ Observed Frequency (GHz)
D Calbration Setup 330{0000 335/0000 340jo000 345/0000 350/0000 355j0000 360/0000

[ Control and Performance
[} Technical Justification

Isc

0 5(3/1;

2| 6(4.2)
lco v=0 32

330l0000 33500000 340]0000 aaﬁkmm: 35000000 355l0000 360l0000
Rest Freqlencyf(GH]

Overlays: Receiver Bands. Transmission DSB Image [¥] Spectral Lines| Select Lines to Overlay.
Water Vapeur Column Density: @ Automatic Choice ( Manual Choice 62mm (4th Octile)
Viewport: Pan to Spectral Window | ZoomtoBand |  Reset |
Spectral Type
® spectral Line
Spectral Type © single Continuum
O spectral sean

Produce image sidebands (Bands 9 and 10 only) []

Polarization products desired O XX @ DUAL O FULL
Spectral Setup Errors
Spectral Line
Baseband-1

Fraction Centre Freg Centre Freq Spec. Representative
i oy, bor) Transition Bandwidth, Resolution (smoothed) s e L
/2 345.79599 GHz 345.76598 GHz 32 234.375 MHz{ 203 km/s), 282.227 kHz( 0.245 km/s) 2 0]
11/2 345.14897 GHz 345.11902 GHz 5(5.1)-6(4.2) 234.375 MH2(_ 204 km/s), 282.227 kHz( 0.245 km/s) 2 Q
( l| [ Add spectral window centred on a spectral ine | | dd spectral window manually |[ Delete | [ show image spectral windows
Baseband-2
Add spectral window centred on a spectral ne | [ Add spectral window manually || D vinc

Baseband-3

Baseband-4

Q e
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Eile Edit View

Project Structur

Proposal | Pr

Unsubmitted Prop;

Example 2

% imr Proposal

% (3 Planne
¢ 8 Sci

oopood

Transition Filter

Create spectral windows centred on spectral |

fTransitions matching your filter settings:

Perspective 1

carbon® | double-click column header for primary sort, single-click subsequent columns for secondary sorting. Single elicks wil reverse sort order of already selected columns.)
D Transition ~ Description Rest Frequency & Sky Frequency Upper-state Energy. Lovas Intensity sij = Catalog =
Include description Garbon fonoride 42847656 otz 627064 Gtz ofine Ll
Carbon Monosulfide 34288785 862251 GHz Offine
Frequency Filters 5 c 850504 Gy
ALMA Band COv=03-2 ‘Carbon Monoxide 345.795990 Ghz -775208 GHz offline
A CBTy Carbon 1 Line 346.931502 GHz 910652 GHz [offine
o T
Sky Frequency (GHz)
—
R R
M
Receiver/Back End Configuration
Alllines
® Potentially selectable lines.
© Lines in defined spws 355,
O Filtering unobservable lines T ————
Upper-state Energy (K) Spectral windows in this baseband (maximum of four)
Min | of max | o] Transition = Description Rest Frequency == Sky Freguenc
| T T EVEXTEvTS AT Siisereicn =
Molecule Filter / Environment 502 v=0 5(5.1)6(4,2) 345.148971 GHz 345.128228 GHz
COv=032 345.795990 GHz 345.775208 GHz
Show [all atoms and molecules oS

Can't find the transition you're looking for in.
the offine pool? Find more in the online:
splatalogue.

[ Search Online ]

[ Rese Filters ]

cance( |

ntative
dow

Hinn

S

Ql




Example 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2

Eille Edit View Tool Search Help

(Gl (@]

Perspective 1

Project Structure
Proposal | Pr

[Editors

Spectral Setup

Unsubmitted Proposal

i Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)

[ General

[ Field setup

[ spectral Setup 4—
[ calibration Setup

[ Control and Performance

[} Technical Justification

Visualisation

In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other.

Leftrright click to zoom in/out, grab siiding bar to pan
Note: Moving LOL here is for experimentation only - actual setup determined by the windows.

Observed Frequency (GHz)
345/00(

330]0000 335/0000 340J0000 00

350/0000 355J0000 360]0000

1 spectral windows

Continuum
330l0000 33500000 340]0000 aaﬁkmm: 35000000 355l0000 360l0000
Rest Frequency (GHZ
Overlays: Receiver Bands Transmission DSB Image [] Spectral Lines| Select Lines to Overlay
Water Vapour Column Density: @® Automatic Choice C Manual Choice [1.262mm (4t Octile}
Viewport: Pan to Spectral Window | ZoomtoBand |  Reset |
Spectral Type
® Spectral Line
Spectral Type © single Continuum
© Spectral Scan
Produce image sidebands (Bands 9 and 10 only) []
Polarization products desired © XX ®DUAL O FULL
Spectral Setup Errors
spectral windows | =
. Baseband-1
] Fraction Centre Freq Centre Freq Spec. Representative
I n b aS e b an d - e (eky,bar) Transition Bandwidth. Resolution (smoothed) ey Window
345.76509 GHz 345.76508 GHz 117.188 MHz{ 102 kmys), 282.227 kHz{ 0.245 kmjs) E ®
33511002 GHz 117.188 MHz( 102 kmys), 282.227 kHz( 0.245 kmjs) E (e}
33395342 GHz 117.188 MHz( 102 kmys), 282.227 kHz( 0.246 kmjs) 3 e}
| Add spectral window centred on a spectraline | [ add spectral window manually |[ Delete | [ Show image spectral window
Baseband-2
':FuHi 333.00000 GHz 332.97110 GHz [Continuum 11875.000 MHz( 1688 kmys), 31.250 MH2(28.136 kmjs) n ]

Modify accordingly

Ql

a2

| Add spectral window centred on a spectral line | | Add spectral window manually |[ Delete | [Jshow image ow
I n b aS e b al I d = 2 foseband
Add spectral window centred on a spectral ine | | _Add spectral window manually || Delere | [ show image -

Baseband-4




Example 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2

Eile Edit View It

[@]g]

Project Structure 4[Editors
Proposal

search  Help Perspective 1

Spectral Setup

Unsubmitted Proposal
% i Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[} spectral Setup 4—
[ calibration Setup
[ Control and Performance
[} Technical Justification

Visualisation

In the table below, it is possible to define up to 16 spectral windows, 4 per baseband as long as the total Fraction per baseband is no more than 1.
Each baseband is 2GHz wide and can be separately configured i.e. each spectral window can have a different bandwidth and resolution.
Note that for bands 3 to 8, it is not possible to put 3 basebands in one sideband and the fourth one in the other.

Leftrright click to zoom in/out, grab siiding bar to pan
Note: Moving LOL here is for experimentation only - actual setup determined by the windows.

Observed Frequency (GHz)
330{0000 335/0000 340jo000 345/00(

00 350/0000 355J0000 360]0000

ontinuum
330l0000 335l0000 3400000 ., 3a3lbooo 350/0000 35510000 360l0000
Viewport: | Pan toSpectral Window | ZoomtoBand |  Reset |
Spectral Type
® Spectral Line
Spectral Type © single Continuum
© Spectral Scan
Produce image sidebands (Bands 9 and 10 only) []
Polarization products desired © XX ®DUAL O FULL
Spectral Setup Errors
Spectral wWindows
. Baseband-1
] Fraction Centre Freq Centre Freq Spec. Representative
I n b aS e b an d - e (eky,bar) Transition Bandwidth. Resolution (smoothed) ey Window L
345.76509 GHz 345.76508 GHz cov=032 117.188 MHz{ 102 kmys), 282.227 kHz{ 0.245 kmjs) E ®
33511002 GHz 502 v=05(5,1)6(4.2) 117.188 MHz( 102 kmys), 282.227 kHz( 0.245 kmjs) E (e}
33395342 GHz 0345 29-28 117.188 MHz( 102 kmys), 282.227 kHz( 0.246 kmjs) 3 e}
Add spectral window centred on a spectral ine_| | _Add spectral window manually || pelete | [ b ]
Baseband-2
333.00000 GHz [332.97110 GHz [Continuum [1875.000 MHz( 1688 km/s), 31.250 MH2(28.136 km/s) it [C ]
.
.
1 SpECtral windows ‘ MNMadif Aal ‘
| Add spectral window centred on a spectral ine | [ Add spectral window manually |[ Delete | [ age spectral v IVI Od ITy aCCO rd I n g Iy
in baseband-2

Add spectral window centred on a spectral Ine_| [

Explore different setups

q afv][?]
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ALMA Observing Tool (validation OT) - Example 2

Perspective 1

Project Structure [Editors
¥ =
Proposal " Spec Calibration Setup
Unsubmitted Proposal

¥

Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
D
[ Control and Performance
[} Technical Justification

Ql

[afvlz]

Select calibration strategy.

Goal Calibrators

8y default, calibrators will be selected automatically at runtime and a single observation will be used to calibrate the bandpass and flux scale.
® System-defined calibration (recommended)
© System-defined calibration (force separate amplitude calibration using solar-system object)

O User-defined calibration

Astrometry

If you wish positional accuracy that is better than that provided by default (see the Proposer's Guide for more information) then select enhanced accuracy.
@ Standard positional accuracy (default)
) Enhanced positional accuracy

DGC Override (observatory-use only)




Example 2: Line observations of single target

ALMA Observing Tool (validation OT) - Example 2
Eile He Perspective 1

[@e] EAFPIA]
Project Stru
Proposal
Unsubmitted Proposal
% i Example 2
% i Proposal
¢ [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup

[} Control and Performance 4—

[} Technical Justification

[Editors

Spectral | Spatial | Control and Performance

These parameters are used to control various aspects of the observations, including the required antenna configurations and integration times.

Control and Performance

Configuration Information

Antenna Beamsize (1.13*A/D) 12m 16.841 arcsec 7m 28.870 arcsec

Number of Antennas 12m 43 7m 10 T 3

ACA Tm configuration Most compact 12m configuration Most extended 12m configuration

Longest baseline 0.049 km 0.161 km 8.548 km

Synthesized beamsize 3.697 arcsec 1.002 arcsec 0.020 arcsec

Shortest baseline 0.009 km 0.015 km 0.113 km

Maximum recoverable scale 19.468 arcsec 8.503 arcsec 0.420 arcsec

Desired Performance
Desired Angular Resolution (Synthesized Beam) O Single ® Range (* Any ( Standalone ACA

| |arcsec | w| to [0.80000
5.00000 equivalent to 79.899 mK

.20454 K

[0.50000

Largest Angular Structure in source

Desired sensitivity per pointing ®0.800"

Bandwidth used for Sensitivity
Override OT's sensitivity-based
time estimate (must be justified)

Science Goal time estimate
(includes configuration and beam information|

Simultaneous 12-m and ACA observations

RepresentativeWindowResolution |

[RepresentativeWindowBandwidth
RepresentativelWindowResolutiony.
|AggregateBandwidth
lLargestWindowBandWidth
FinestResolution

luser

Are the observations time-constrained?

© Yes @ No

Frequency Widt!

Explore the different
options

Representative WindowBand Width: the bandwidth of the spectral window chosen as the representative
spectral window (and containing the Representative Frequency) in Section 6

Representative WindowResolution (default): the (Hanning-smoothed) spectral resolution of the repre-

sentative spectral window, taking into account spectral averaging

Aggregrate Bandwidth: the summed bandwidth of all your selected spectral windows
Largest WindowBandwidth: the bandwidth of your widest spectral window defined

FinestResolution: the finest (Hanning-smoothed) resolution of any spectral window, taking into ac-

count spectral averaging

User: a bandwidth of your choice (useful if you are intending to smooth your data after observation
to achieve a certain

/N)

Ql

[afvlz]




Example 2: Line observations of single target

ALMA Observing Tool (Validation OT) - Example 2
File Edit View Tool Search Help Perspective 1

(Gl (@]

Project Structure [Editors
Proposal | Pre 5

Control and Performance

These parameters are used to control various aspects of the observations, including the required antenna configurations and integration times. Time Estimate

Control and Performance

Unsubmitted Proposal
i Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)

Note: The time in brackets is that required to reach the sensitivity.
Operational requirements often mean that the actual observed time

Configuration Information

[} General is longer, especially for mosaics. Please see the User Manual for more

[ Field setup Antenna Beamsize (1.13*A/D) 12m 16.841 arcsec 7m 28.870 arcsec details.

[ spectral Setup Number of Antennas. 12m 43 m 10 TP 3 Input Parameters.

[0 calibration Setup Requested sensitivity 5.000 mly
8o e e < ACA 7m configuration Most compact 12m configuration Most extended 12m configuration Bandwidth used for sensiivty QTR
[} Technical Justification Longest baseline 0.049 km 0.161 km 8.548 km 345.766

Representative frequency (sky, first source)

GHz
Synthesized beamsize 3.697 arcsec 1.002 arcsec 0.020 arcsec

Estimated Total time for Science Goal 1.71h
Shortest baseline 0.009 km 0.015 km 0.113 km
Maximum recoverable scale 19.468 arcsec 8.503 arcsec 0.420 arcsec Cluster 1

05:35

Desired Performance Source Name RA Dec Velocity =
OPS 370 000 km/s

Desired Angular Resolution (Synthesized Beam) O Single ® Range (* Any ( Standalone ACA

[0.50000 | |arcsec | w| to [0.80000
Largest Angular Structure in source 5.00000

Possible Configuration Combinations.

. 1zZm@) [ 12zm(2 | 7m ™
n equivalent to 79.899 mK. @ 0.800

Nominal Beam(®) | M2 expected

Desired sensitivity per pointing 5.00000 iliatl
43-2 [None  [No  [No 10648 x 0.719 [1.5
and 0.20454 K ©0.500"
S —
Bandwidth used for Sensitivity ([RepresentativewindowResolution || Frequency width 0.282227 MHz
Override OT's sensitivity-based
time estimate (must be justified) O Yes ® No Input Parameters
Precipitable water vapour (all sources) 1.262mm (4th Octile)

Time required for 12m (1) [C43-2]

Science Goal time estimate
(includes configuration and beam information) | "M Estimate
@ N

simultaneous 12-m and ACA observations O vee Time on source per pointing (first source)  52.41 min [ 51.75 min]
Are the observations time-constrained? O Yes ® No Total number of pointings (all sources) 1

Number of tunings 1

Total time on source 52.41 min [51.75 min]

Total calibration time 44.07 min

Other overheads 5.93 min

Total time for 1 58 execution 51.21 min

Number of SB executions 2

Total time to complete 5B 171h

calibration Breakdown per SB execution

2 x Pointing 4.00 min

1 x Amplitude/bandpass 10.00 min

4 x Phase 2.00 min

5 x Atmospheric 3.33min

Calibration overheads 2.70 min L

Estimated total time for cluster 1 1.71h

ql V2]
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Perspective 1

Project Structure
Proposal | Pr

[Editors
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% i Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance

[) Technical Justification 4—

Ql

a2

Sensitivity

Line width / bandwidth used for sensitivity ( 10.00 kmys / 244.70 m/s ) = 40.87

Spectral Dynamic Range (continuum flux / line rms): 201.31

Requested RMS over 244.701 m/s  is 5.00 mjy For a peak flux density of 50.00 mjy , the S/N is 10.0
Achieved RMS over the total 2.227 GHz bandwidth is 55.93 uly, 0.89 mK-2.29 mK  For a continuum flux density of 1.00 Jy, 15.98 K-0.91 K . the achieved S/N is 17880.2

For a peak line flux of 50.00 mjy , the achieved S/N over 1/3 of the source line width { 10.00 km/s /3 = 3.33 kmis ) is 37.2

For line observations also justify the bandwidth used for the sensitivity calculation.

1a, bla, bla, bla, bla, bla, bla, bla

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Requested Largest Angular Scale 5.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal
[Bla, bla, bla, bla, bla, bla, bla, bl a
la, bla, bla, bla, bla, bla, bla, bla

a, bla, bla, bla, bla, bla, bla, bla, bla,

Correlator configuration

line width / representative spectral window resolution: 10.00 km/s / 244.69 m/s = 40.87

Representative spectral window width : 101.61 km/s

You may want to consider spectral averaging to lower the data rate

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.

la, bla, bla, bla, bla, bla, bla, bla

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
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Perspective 1

Project Structure
Proposal

[Editors

Unsubmitted Proposal

% i Example 2
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance

[) Technical Justification 4—

For a peak line flux of 50.00 mjy , the achieved S/N over 1/3 of the source line width { 10.00 km/s /3 = 3.33 kmis ) is 37.2

Line width / bandwidth used for sensitivity ( 10.00 kmys / 244.70 m/s ) = 40.87

Spectral Dynamic Range (continuum flux / line rms): 201.31

Sensitivity
Requested RMS over 244.701 m/s  is 5.00 mjy For a peak flux density of 50.00 mjy , the S/N is 10.0
Achieved RMS over the total 2.227 GHz bandwidth is 55.93 uly, 0.89 mK-2.29 mK  For a continuum flux density of 1.00 Jy, 15.98 K-0.91 K . the achieved S/N is 17880.2

For line observations also justify the bandwidth used for the sensitivity calculation.
Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
1a, bla, bla, bla, bla, bla, bla, bla

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Requested Largest Angular Scale 5.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla

Correlator configuration

line width / representative spectral window resolution: 10.00 km/s / 244.69 m/s = 40.87

Representative spectral window width : 101.61 km/s

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.
‘You may want to consider spectral averaging to lower the data rate

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla

Check Point!

Ql

Save your project now (aot file)
|

[alvlz]| f=




Lets propose!

(Phase 1)

Example 3: Mosaic observations (e.g. mapping a star-
forming filament)

e 1 Science Goal with 1 mosaic target

To do:
1) Open template created before

2) Add Science Goal
3) Fill in General field
4) Save it as Example 3
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Perspective 1

Project Structure

Proposal | Program

[Editors

Unsubmitted Proposal

Example 3

% i Proposal

% [ Planned Observing

¢ (8] ScienceGoal (Science Goal 1)

[ General
[} Field setup 4—
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

Option A

a2

0.0

N
@ @ [&[ @ [Tx [ 630,597
I

Image Filename sky3/cache/jsky11132322524105307378.fits

FOV Parameters

=)

Representative Frequency (Sky) 333.000 GHz
Antenna Diameter ® 12m

Antenna Beamsize (HPBW) 17.486 arcsec
Show Antenna Beamsize

Image Query

Image Server

=
|Digitized sky (Version 11} at ESO [~]

Validation | Validation History

HOPS 370

Source

Source Name Hops 370 | Resove |
Choose a Solar System Object? [] Name of object [Unspecified

Source Coor

Source Radi

Target Type

Expected Source Properties

]
system [ICRS dizplny

Parallax [0.00000 mas.

dinates. RA | 05:35:27.6220 | PM RA [0.00000

] [meshyr |~

Dec  [-05:09:33.778
Resolved by simbad.u-strasbg.fr (SIMBAD)

PM DEC [0.00000 masyr :

Select for

ial Velocity. 0.000 kmys| | [lsrk Le| 2 [2,000000000 | Doppler Type [RaDI
© Individual Pointing({ ® 1 Rectangular Field

Peak Continuum Flux Density per Synthesized Beam [30.0

M

Continuum Linear Polarization 0.0 per cent
Continuum Circular Polarization 0.0 per cent
Peak Line Flux Density per Synthesized Beam 0.00000
Line Width 0.00000
Line Linear Polarization 0.0 per cent
Line Circular Polarization 0.0 per cent
Rectangle
=
Coords Type ® Relative O Absolute
Field Center Offset(Longitude) [0.00000 =
Coordinates 0 S al
Offset(Latitude} |0.00000
p length 0.00000 1.
q length 0.00000 geol I Ie 3
Position Angl¢/0.00000
Spacing  [0.51003 [fraction of antenna beamsize [~] | Reset to fiyquist |
#Pointings  12m Array 0 Export
Add Source || Load from File... |[ ExporttoFile.. || Clonesource || Deletesource ||

C

osaic

r

| Description

Suggestion
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ALMA Observing Tool (validation OT) - Example 3

EAFPIA] Perpecine 3

[Editors

Eille Edit View Tool Search Help

Project Structure

Proposal | Pr

Unsubmitted Proposal

spatial [ Field setup

Example 3 Spatial Image & HoPS 370 |
% i Proposal e
% [ Planned Observing 2=
% (&) ScienceGoal (Science Goal 1)
Source Name Hors 370 | Resolve |

[ General &
[ Field setup 4— Choose a Solar System Object? [] Name of object [Unspecified
[ spectral Setup

el Parallax [0.00000 mas :
[0 calibration Setup ; System
[} Control and Performance Source Coordinates . 95:3527.6220 PMRA [0.00000 masiyr |~

[} Technical Justification

Dec  [-05:00:33.778 PM DEC [0.00000 [masyr v ]
Source Radial Velocity 0.000 rk | +| 2[0.000000000 | Doppler Type [RADIO [~]

Target Type 2 Individual Pointing(f”® 1 Rectangular Field

Expected Source Properties

Peak Continuum Flux Density per Synthesized Beam [30.00000 [~
Continuum Linear Polarization 0.0 per cent
Continuum Circular Polarization 0.0 per cent
Peak Line Flux Density per Synthesized Beam 0.00000
Line Width 0.00000
I
@ @ [z[®[1x [ 161 [ 1isw0 Line Linear Polarization 0.0 per cent
[

Line Circular Polarization
05:35:39.910, 05:11:27.73 (12000 0.0 per cent
Image Filename sky3/cachefskyl1132322524105307378 fits| | Rectangle

=]

Mosaic

FOV Parameters Coords Type @® Relative ) Absolute

Representative Frequency (Sky) 104.500 GHz Field Center Offset(Longitude) |0.00000

Antenna Diameter ® 12m Coordinates

Antenna Beamsize (HPBW) 55.722 arcsec Offset(Latitude} [0.00000

Show Antenna Beamsize

Option A

plength  [0.5

Image Query -

glength [0 L
Image Server |Digitized sky (version 11} at ESO [+]

Position Angld10.0
Image Size(arcmin) [10.0 Query 9

Spacing 0.51093 [fraction of antenna beamsize ||| Reset to fiyquise |

#Pointings  12m Array 21 [ fexpor

Add source || Load from Fie.. || Exdlrtofile.. || Clonesource [ Delere

Validation | Validation History

Description Suggestion

Up to 150
pointings

Y [Alv]?]




Example 3: Mosaic observations
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Search Help

Perspective 1

To see the pointings

Project Structure
Proposal | Program
Unsubmitted Proposal
7 i Example 3
¢ [ Proposal

< Editors
Spectral | spatial | Field Setup

Spatial Image

[zl
Source
% [ Planned Observing ==
% (&) ScienceGoal (Science Goal 1)
Source Name Hors 370 | Resolve |
[ General &
[ Field setup 4— Choose a Solar System Object? [] Name of object [Unspecified

[ spectral Setup

el Parallax [0.00000 mas :
[0 calibration Setup ; System
[} Control and Performance Source Coordinates . 95:3527.6220 PMRA [0.00000 masiyr |~

[} Technical Justification

Dec  [-05:00:33.778 PM DEC [0.00000 [masyr v ]
Source Radial Velocity 0.000 0.000000000 | Doppler Type [RADIO [~]

Target Type 2 Individual Pointing(f® 1 Rectangular Field

Peak Continuum Flux Density per Synthesized Beam [30.00000

Expected Source Properties

Continuum Linear Polarization 0.0 per cent
Continuum Circular Polarization 0 Jpercent
Peak Line Flux Density per Synthesized Beam 0.00000

Line Width 0.00000

@ @ [a|@[1x [ 374,472 | 123760 Line Linear Polarization o0 Ipercent
[ 05:35:22.545, 05:06:37.77 (12000 D S RE ST oo Jpercent

Image Filename [sky3/cache/jsky11132322524105307378.fits| || Rectangle

=]

= 0l (R = Coords Type ® Relative () Absolute
tl O n A Representative Frequency (Sky) 104.500 GHz Field Center Offset(Longitude) |0.00000 =

AT ®12m Comdnates M osaic
Antenna Beamsize (HPEW) 55722 arcsec Offset(Latitude) [0.00000
Show Antenna Beamsize

plength  [0.5
Image Query -

El qlength  [5.0 L

Image Server |Digitized sky (version 11} at ESO [+]

Position Angl¢10.0
Image Size(arcmin) [10.0 Query 9

spacing  [0.51003 [fraction of antenna beamsize ||| Reset to fiyquise |

#Pointings  12m Array 21 [ fexpor

Addsource || Load from Fie.. || Exglrtofile.. || clonesource [ Delete source || All Sources

Validation | Validation History

Description Suggestion

Up to 150
pointings

Y [Alv]?]
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Proposal | Pr

[Editors

spatial [ Field setup
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% i Example 3
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[} Field setup 4—
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

Option

a2

Spatial Image

@ @ [a| @ [1x [ 37442 | 123760
‘ 05:35:22.545, -05:06:37.77 (J2000)
Image Filename sky3/cache/jsky11132322524105307378 fits

FOV Parameters

=]

Representative Frequency (Sky) 104.500 GHz
Antenna Diameter ® 12m

Antenna Beamsize (HPBW) 55.722 arcsec
Show Antenna Beamsize

Image Query

Source

Source Name

2=

Hors 370

| Resolve |

Choose a Solar System Object? []

Source Coordinates

Source Radial Velocity

Target Type

Expected Source Properties

Rectangle

System

RA 05:35:27.6220
Dec  [-05:09:33.778

T —

© Individual Pointing(:

Continuum Linear Polarization
Continuum Circular Polarization

Peak Line Flux Density per Synthesized Beam

Line Width

Line Linear Polarization
Line Circular Polarization

Sexagesimal

% 1 Rectangular Field

Peak Continuum Flux Density per Synthesized Beam [30.00000

Name of object [Unspecified

Parallax [0.00000 mas |~
PMRA [0.00000 [masyr [~]
PM DEC [0.00000 [masyr v ]

0.000000000 | Doppler Type [RADIO [~]

0.0 per cent
0.0 per cent
0.00000

0.00000

0.0 per cent
0.0 per cent

Field Center
Coordinates

plength  [0.5

Offset(Longitude) [0.00000
Offset(Latitude} [0.00000

=]

Mosaic

Coords Type @® Relative ) Absolute

g L — eOI I Ie1.r
Image Server |Digitized sky (version 11} at ESO [+]
Position Angld10.0
Image Size(arcmin) [10.0 Query osition Ang
Spacing  [0.51093 | [fraction of antenna beamsize [~ |[ Reset to fiyquise |

options

Explore the different

#Pointings  12m Array 21

oo |

| Load from Fie.. || exg

toFile... || Clonesource || Delete source || Delete All source

Description

Suggestion

Up to

pointings

150
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ALMA Observing Tool (validation OT) - Example 3

Elle Edit View Tool Search Help Perspective 1

@

Project Structure [Editors
|( Proposal | Pr Spectral
Unsubmitted Proposal
% i Example 3
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
N
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

spatial [ Field setup

Primary beam (red)
Imaged area (green)
(we haven't set the spectral setup yet)

Spatial Image “HoPs 370 |

Source

=
Source Name [Hoes 370 | Resoie |
Choose a Solar System Object? [] Name of object [Unspecified
Sexagesimal .
R Parallax [0.00000 mas |+
Source Coordinates wn [a527 6% PMRA [0.00000 masiyr |~
Dec  |-05:00:33.778 PM DEC [0.00000 masiy |~

Source Radial Velocity

2 [0.000000000 | Doppler Type [RADIO -

@ Individual Pointing(s)

Target Type 0 1 Rectangular Field
Expected Source Properties
EE
- Peak Continuum Flux Density per Synthesized Beam [30.00000
t I O n Continuum Linear Polarization 0.0 per cent
Continuum Circular Polarization oo Ipercent
Peak Line Flux Density per Synthesized Beam 0.00000
Line width 0.00000
@ @ fa] & o [ w0220 | 145940 Line Linear Polarization 0.0 per cent
[ 05:35:22.082, -05:10:51.58 (j2000] o S (el {m .0 |percent
Image Filename sky3/cache/jsky11132322524105307378.fits Field Center Coordinates.
(Y FETEI G = Coord Type ® Relative O Absolute
Representative Frequency (Sky) 333.000 GHz Offset nit.[arcmin [-]
Antenna Diameter ®12m #Pointings 5
Antenna Beamsize (HPBWY) 17.487 arcsec e PEEI i
Show Antenna Beamsize 0.00000 000000 =
050000 0.00000
(e T sy 0.00000 0.50000 r
El 0.00000 -0.50000 =
Image Server |Digitized sky (version 1) at EsO [~] 050000 0.00000 ~
Image o0 || Query ] [ add ]| [_import ][ Export |

Addsource || Load from Flev. || ExporttoFle.. || Conesource || oelet
Add pointings
manually

Q| [Alv][2




Example 3: Mosaic observations

ALMA Observing Tool (validation OT) - Example 3

Search Help

Perspective 1

Project Structure

Proposal | Program

[Editors

spatial [ Field setup

Unsubmitted Proposal

% i Example 3
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
N
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

Option

Primary beam (red)
Imaged area (green)

(we haven't set the spectral setup yet)

Spatial Image “HoPs 370 |

Source

Source Name

Source Coordinates

Choose a Solar System Object? []

Source Radial Velocity

Target Type

Expected Source Properties

Line Width
I
@\ @\ ]E[ Q\‘ X ‘ 380, 220 ‘ 14394.0 Line Linear Polarization
‘ = = Line Circular Polarization

05:35:22.082, -05:10:51.58 (]2000)
Image Filename sky3/cache/jsky11132322524105307378.fits Field Center Coordinates.

Peak Line Flux Density per Synthesized Beam

=
[Hoes 370 | Resoie |
Name of object [Unspecified
Sexagesimal .
- Parallax [0.00000 mas | v
RA 05:35:27.6220 PMRA [0.00000 masyr_|~|
Dec  |-05:00:33.778 PM DEC [0.00000 masiy |~
X 2 [0.000000000 | Doppler Type [RADIO -
@ Individual Pointing(s) ) 1 Rectangular Field
==
Peak Continuum Flux Density per Synthesized Beam [30.00000
Continuum Linear Polarization 0.0 per cent
Continuum Circular Polarization 0 Jpercent

0.00000

0.00000
0.0 per cent
0.0 per cent

(Y FETEI G = Coord Type ® Relative O Absolute

Representative Frequency (Sky) 333.000 GHz Offset nit.[arcmin [-]

Antenna Diameter ®12m #Pointings 5

Antenna Beamsize (HPBW) 17.487 arcsec RA [arcmin] b B

Show Antenna Beamsize 0.00000 000000 =

050000 0.00000
(e T sy 0.00000 0.50000 r
El 0.00000 -0.50000 =
Image Server |Digitized sky (version 1) at EsO [~] 050000 0.00000 ~
Image o0 || Query ] [ add ]| [_import ][ Export |
Add source || Load from File.. ][ ExporttoFile.. |[ cloneseurce | o= | oL |

Explore the different
options

[Alv][2

Add pointings
manually




Example 3: Mosaic observations

ALMA Observing Tool (validation OT) - Example 3

Elle Edit View Tool Search Help Perspective 1

(Gl (@]

Project Structure {[Editors
|( Proposal | Pr Spectral Setup
Unsubmitted Proposal Left/right click to 200m injout, grab sliding bar to pan B
Example 3 Note: Moving LOL here is for experimentation only - actual setup determined by the windows
% i Proposal Observed Frequency (GHz)
4 7 Planned observing 60{0000 80{0000 100J0000 , , 140/0000 , ,
¢ {8 ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup 4—
[ calibration Setup
[ Control and Performance
[} Technical Justification
lcantinuum
[continuum
60l0000 800000 100l0000) 120/0000 140l0000
Rest Freguency (GHz)
Overlays: Receiver Bands Transmission DSB Image [ Spectral Lines| Select Lines to Overlay.
Water Vapour Column Density: ® Automatic Choice (O Manual Choice [5.186mm (7th Octile) | - |
Viewport: Pan to Spectral Window | ZoomtoBand |  Reset |
Spectral Type
EE|=
© Spectral Line.
Spectral Type ® single Continuum 4—
) Spectral Scan
Produce image sidebands (Bands 9 and 10 only) []
Polarization products desired O XX @® DUAL O FULL
Spectral Setup Errors
Single Continuum
EE
Receiver Band |3 [64.0-116.0 GHz] [~
Reset to Standard Frequency
Sky Frequency  [97.50000
Rest Frequency  97.500000 GHz
® Low spectral resolution (TDM)
O High spectral resolution (FDM} [
Baseband-1
fractn it 1:5;] 3“;1;’1;’3" Transition Bandwidth, Resolution (smecthed) i"vzc' (D
L(Full) 190.50000 GHz 190.50000 GHz |Single Continuum 11875.000 MHz( 6211 km/z), 31.250 MH2(103.519 km/s) I8 (]
Oshe ge spectral windows
Baseband-2
[x{Fully [92.50000 GHz [92.50000 GHz [Single Continuum [1875.000 MHz( 6077 km/s), 31.250 MH2(101.281 kmys) n [*] |
[]'Show image spectral w
Baseband-3
[2(Fully [102.50000 GHz [102.50000 GHz [Single Continuum [1875.000 MHz( 5484 km/s), 31.250 MHz(91.400 kmys) n [] |
[ Show image spectral windows
Baseband-4
rzu:um [104.50000 GHz 1104.50000 GHz [Single Continuum 11875.000 MHz( 5379 kmys), 31.250 MHz(89.651 kmjs) n o) |
QJ ‘ =




Example 3: Mosaic observations

ALMA Observing Tool (validation OT) - Example 3

Elle Edit View Tool Search Help Perspective 1

(Gl (@]

Project Structure 4[Editors
ram I

Proposal | Pr Field Setup

Unsubmitted Proposal
Example 3
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
N
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

Primary beam (red)
Imaged area (green)
at Band 3

Spatial Image
Source
=
Source Name [Hoes 370 | Resoie |
Choose a Solar System Object? [] Name of object [Unspecified
Sexagesimal .
R == Parallax [0.00000 mas |+
Source Coordinates N 53527 6920 PMRA [0.00000 masiyr |~
Dec  |-05:00:33.778 PM DEC [0.00000 masiy |~
Source Radial Velocity 0.000 2 [0.000000000 | Doppler Type [RADIO -
Target Type @ Individual Pointing(s) 1 Rectangular Field
Expected Source Properties
EE
- Peak Continuum Flux Density per Synthesized Beam [30.00000
t I O n Continuum Linear Polarization 0.0 per cent
Continuum Cireular Polarization o0 Jpercent
Peak Line Flux Density per Synthesized Beam 0.00000 ~]
Line Width 0.00000
@ @, (2] @2 [ 20153305 S TOEN Line Lmea‘r Pu\a‘rlzatmn 0.0 per cent
Line Circular Polarizati
i - ine Circular Polarization 0.0 e

T eSO
Image Filename sky3/cache/jsky11132322524105307378.fits Field Center Coordinates,

FOV Parameters Coord Type ® Relative O Absolute

[2][=
Representative Frequency (Sky) 104.500 GHz Offset Unit|arcmin "‘
Antenna Diameter ®12m #Pointings 5
Antenna Beamsize (HPBW) 55.722 arcsec el ot
Show Antenna Beamsize 0.00000 000000 =
050000 0.00000
(e S 0.00000 050000 =
0.00000 -0.50000
Image Server |Digitized sky (version 1) at EsO [~] 050000 0.00000 ~
Image Size{arcmin) [10.0 Query [ add ]| [_import ][ Export |
Add source || Load from File.. |[ ExporttoFile.. ][ Clonesource | Delete source || te All Sources




Example 3: Mosaic observations

ALMA Observing Tool (validation OT) - Example 3

EAFPIA] Perpecine 3

Eille Edit View Tool Search Help

[@]g]

Project Structure 4[Editors

Proposal ) ¥lrs Calibration setup
Unsubmitted Proposal

% i Example 3

Select calibration strategy.
% i Proposal

% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)

[ General
[ Field setup
[ spectral Setup
[ calibration Setup 4—
[ Control and Performance
[} Technical Justification

Goal Calibrators

By default, calibrators will be selected automatically at runtime and a single observation will be used to calibrate the bandpass and flux scale.
® system-defined calibration (recommended)

© System-defined calibration (force separate amplitude calibration using solar-system object)

O User-defined calibration

Astrometry

If you wish positional accuracy that is better than that provided by default (see the Proposer's Guide for more information) then select enhanced accuracy.
@ Standard positional accuracy (default)
) Enhanced positional accuracy

DGC Override (observatory-use only)




Example 3: Mosaic observations

Eile Edit View Tool Search Help

(Gl (@]

ALMA Observing Tool (validation OT) - Example 3

Perspective 1

Project Structure
Proposal | Pr

[Editors

Control and Performance

Unsubmitted Proposal

% i Example 3
% i Proposal
% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

e

Option A:
rectangular
mosaic
(21 pointings)

These p

Control and Performance

Configuration Information

Number of Antennas 12m 43

Antenna Beamsize (113 *A /D) 12m 55.722 arcsec

are used to control various aspects of the observations, including the required antenna configurations and integration times.

7m 95.523 arcsec

7m 10 T 3

Time Estimate

Note: The time in brackets is that required to reach the sensitivity.
Operational requirements often mean that the actual observed time
is longer, especially for mosaics. Please see the User Manual for more
details.

Input Parameters.

ACA 7m configuration

Most compact 12m configuration  Most extended 12m configuration

Longest baseline
Synthesized beamsize
Shortest baseline

Maximum recoverable scale

0.049 km
12.233 arcsec
0.009 km

64.416 arcsec

0.161 km
3.315 arcsec
0.015 km

28.136 arceec

8.548 km
0.096 arcsec
0.113 km

1.390 arcsec

Desired Performance

Largest Angular Structure in source

Desired mosaic sensitivity

Bandwidth used for Sensitivity

Override OT's sensitivity-based
time estimate (must be justified)

Science Goal time estimate
(includes configuration and beam information)
Simultaneous 12-m and ACA observations.

Are the observations time-constrained?

Desired Angular Resolution (Synthesized Beam) O Single ® Range () Any ©J Standalone ACA

[0.50000 = to [0.80000

5.00000

[30.00000 | quivalent to 5.2484 MK @0.800 "
and 0.013436 K @®0.500"

|AggregateBandwidth |~ | Frequency width 7.500000 GHz
O Yes ® No

Time Estimate

O Yes @ N
O Yes ® No

Cluster 1

Requested sensitivity 0.03000 mjy
Bandwidth used for sensitivity 7.500 GHz
Representative frequency (sky, first source) woaa00
Estimated Total time for Science Goal 245h

Source Name | RA Dec Velocity
[ioPs_370 [05:35:27.6220 [05:09:33.778 [70.000 ks

12-m (1) ‘ 12-m (2)

7-m ‘ ™

Possible Configuration Combinations

Nominal Beam("}

Max expected
axial ratio

435 [None No No

0524 0.558 [Ts

Input Parameters
Precipitable water vapour (all sources)

Time required for 12m (1) [C43.5]

5.186mm (7th Octile)

Time on source per pointing (first source)
Total number of pointings (all sources)

4.37 min [ 4.25 min]
21

NUmBer of tunings. T

Total time on source 1.53 h [1.49 h]

Total calibration time 46.60 min

Other overheads 8.58 min

Total time for 1 5B execution 122h

Number of SB executions 2

Total time to complete SB 2.45h

Calibration Breakdown per SB execution

2 x Pointing 4.00 min

1 x Amplitude/bandpass 5.00 min

10 x Phase 5.00 min L

6 x Atmospheric 4.00 min

Calibration overheads 5.30 min

Estimated total time for cluster 1 2.45h |
Close




Example 3: Mosaic observations

Eile Edit View Tool Search Help

Project Structure

(Gl (@]

ALMA Observing Tool (validation OT) - Example 3

Perspective 1

% [ Planned Observing
¢ (8] ScienceGoal (Science Goal 1)

[ General
[ Field setup
[ spectral Setup
[ calibration Setup
[ Control and Performance
[} Technical Justification

e

Option B:
5x pointings

Control and Performance

Configuration Information
Antenna Beamsize (113 *A /D) 12m 55.722 arcsec

Number of Antennas 12m 43

ACA 7m configuration
Longest baseline 0.049 km
Synthesized beamsize 12.233 arcsec
Shortest baseline 0.009 km
Maximum recoverable scale 64.416 arcsec

Desired Performance
Desired Angular Resolution (Synthesized Beam) O Single @

< Editors
| Proposal | Program ¥lrs Control and Performance
Unsubmitted Proposal
Example 3 These p: are used to control various aspects of the observations, including the required antenna configurations and integration times.
¢ [ Proposal

7m 95.523 arcsec

7m 10 T 3

Most compact 12m configuration  Most extended 12m configuration
0.161 km 8.548 km
3.315 arcsec 0.096 arcsec
0.015 km 0.113 km
28.136 arcsec 1.390 arcsec

Range () Any © Standalone ACA

Bandwidth used for Sensitivity

Override OT's sensitivity-based

time estimate (must be justified) O Yes ® No

Science Goal time estimate

Simultaneous 12-m and ACA observations.

O Yes @ No

Are the observations time-constrained? O Yes ® No

[0.50000 = to [0.80000
Largest Angular Structure in source [s.00000 |
Desired sensitivity per pointing [30.00000 | quivalent to 5.2484 MK @0.800 "
and 0.013436 K @®0.500"

|AggregateBandwidth |~ | Frequency width 7.500000 GHz

(includes configuration and beam information) |_1'me Estimate

Time Estimate

Note: The time in brackets is that required to reach the sensitivity.
Operational requirements often mean that the actual observed time
s longer, especially for mosaics. Please see the User Manual for more

details.
Input Parameters
Requested sensitivity 0.03000 mjy
Bandwidth used for sensitivity 7.500 GHz
Representative frequency (sky. first source) i
Estimated Total time for Science Goal 115h
Cluster L
Source Name | RA | Velocity
FOFS 370 0 [70.000 km/s

le Configuration Combinations

12m (1) | 12:m(2) 7-m T

Nominal Beam(”) M

lax expected
axial ratio

435 [None™"TNo "o [0.524°%0.558 L5

Input Parameters

Precipitable water vapour (all sources) 5.186mm (7th Octile)

Time on source per pointing (first source)

8.57 min [ 8.38 min]

Total number of pointings (all sources) 5

Number of tunings T

Total time on source 42.84 min [41.88 min]
Total calibration time 22.37 min

Other overheads 3.79 min

Total time for 1 SB execution 1.15h

Number of 5B executions 1
Total time to complete SB 115h

calibration Breakdown per SB execution

2 x Pointing 4.00 min
1 x Amplitude/bandpass 5.00 min
9 x Phase 4.50 min
6 x Atmospheric 4.00 min

Calibration overheads 4.87 min

Estimated total time for cluster 1 1.15h

Close
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Project saved to disk ...

Perspective 1

Project Structure 4[Editors
¥ e
Proposal " Technical Justffication
Unsubmitted Proposal

i Example 3
% i Proposal
% [ Planned Observing
¢ {8 ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup

[ Control and Performance
[0) Technical justification 4—

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.
sensitivity

Requested RMS over 7.500 GHz is 30.00 ujy For a peak flux density of 30.00 mjy , the S/N is 1000.0

Achieved RMS over the total 7.500 GHz bandwidth is 29.58 u)y. 5.17 mK-13.25 mK For a continuum flux density of 30.00 mjy. 5.25 K-13.44 K , the achieved S/N is 1014.3
Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.
For line observations also justify the bandwidth used for the sensitivity calculation.

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
1a, bla, bla, bla, bla, bla, bla, bla

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Requested Largest Angular Scale 5.00 arcsec

ustify the chosen angular resolution and largest angular scale for the source(s) in this Science Goal

Bla, bla, bla, bla, bla, bla, bla, bla, bla, kla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla

Correlator configuration

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.

“You may want to consider spectral averaging to lower the data rate

Bla, bla, bla, bla a bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla
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ALMA Observing Tool (validation OT) - Example 3

Project saved to disk ...

Perspective 1

Project Structure
Proposal

[Editors

Technical Justification

Unsubmitted Proposal

i Example 3
% i Proposal
% [ Planned Observing
¢ {8 ScienceGoal (Science Goal 1)
[ General
[ Field setup
[ spectral Setup
[ calibration Setup

[ Control and Performance
[0) Technical justification 4—

Enter a Technical Justification for this Science Goal, paying special attention to the parameters reproduced below.

sensitivity

Requested RMS over 7.500 GHz is 30.00 ujy For a peak flux density of 30.00 mjy , the S/N is 1000.0

Achieved RMS over the total 7.500 GHz bandwidth is 29.58 u)y. 5.17 mK-13.25 mK For a continuum flux density of 30.00 mjy. 5.25 K-13.44 K , the achieved S/N is 1014.3
Justify your requested RMS and resulting S/N for the spectral line and/or continuum observations.
For line observations also justify the bandwidth used for the sensitivity calculation.

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
1a, bla, bla, bla, bla, bla, bla, bla

Imaging

Requested angular resolution 800.00 mas - 500.00 mas

Requested Largest Angular Scale 5.00 arcsec

Check Point!

ave your project now (aot file)

TrETator ConTgUT St

Justify your correlator set-up with particular reference to the number of spectral resolution elements per line width.

“You may want to consider spectral averaging to lower the data rate

Bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla, bla,
la, bla, bla, bla, bla, bla, bla, bla




Congratulations!

Example 1. Continuum observations of several targets
(e.g. survey of protostars)

Example 2: Line observations of single target (e.g. study
kinematics of a protostellar disk)

Example 3: Mosaic observations (e.g. mapping a star-
forming filament)



Final Recommendations

(thanks George, Adam & Anita!)

Make sure all Co-Is have registered for an account with ALMA (or ESO) so that
they can be listed on the proposal.

Check the source coordinates, velocities and/or redshifts, and spectral settings
before proposal submission. These can be updated later, but if more changes
need to be made, more errors can be introduced.

Use at least four spectral windows. Any spectral window not covering a line of
scientific interest can be used for serendipitous continuum and spectral line
detection.

Use 1920 channels per baseband. The extra channels provide extra spectral
resolution if needed, and if the higher resolution is not needed, the channels can
be averaged together after observing to improve sensitivity.

Do not use 3840 channels per spectral window. The effective spectral
resolution will still be equivalent to 1920 channels.

Do not place important spectral lines near the edges of spectral windows where
the sensitivity of the detectors decreases.

Do not try to gain sensitivity by overlapping the spectral windows. The
instrument doesn’t work that way.

Do not change anything under Calibration Setup unless you know what you are
doing.

Do not specify a single angular resolution unless you absolutely need to. A
program that specifies a range is more likely to be observed.

Use “Any” for the desired angular resolution if you only need to detect the
source.

Do not forget to account for extended source emission in terms of uv coverage.

Do not forget to account for extent of the source emission when estimating the
peak surface brightness.




